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O priručniku 

Priručnik „Korak po korak u 3D štampi“ je nastao  kao deo odobrenog Evropskog 

programa Erazmus+, KA2 Mala partnerstva u oblasti stručnog obrazovanja i obuke, pod 

brojem ugovora 2023-1-RS01-KA210-VET-00015403. 

To je rezultat saradnje stručnih škola Tehnička škola iz Pirota, Srbija, SOU Goce Delchev 

iz Valandova, Severna Makedonija, i 1. EPAL Eleftheroupolija iz Grčke, koje su sve 

aktivno učestvovale u osmišljavanju i razvoju njegovog sadržaja. Autori su profesori 

stručne grupe predmeta u ovim školama: Aleksić Vojislav (Srbija), Pilipovikj Vladimir 

(Severna Makedonija) i Violeta Samioti (Grčka). Saradnici na projektu su: Olivera 

Petrović, prevodilac i Emilija Zafirova Petkov, autor prilagođene verzije ovog priručnika. 

Glavni cilj priručnika je da pruži jasan, detaljan i pristupačan vodič za proces 3D 

štampanja. Namenjen je nastavnicima, učenicima i svima koji su zainteresovani da se 

upoznaju sa osnovnim principima i koracima 3D štampanja. Kroz svoje stranice, priručnik 

ima za cilj da upozna čitaoce sa konceptima i tehnikama 3D štampanja, objasni korak po 

korak proces od dizajna do proizvodnje, unapredi kreativnost, inovacije i digitalne veštine 

i podrži interdisciplinarno učenje integracijom 3D štampanja u različite oblasti nauke. 

Ovaj priručnik služi i kao alat za učenje i kao izvor inspiracije za one koji žele da istraže 

potencijal ove tehnologije. Doprinosi razvoju digitalnih veština i promociji kreativnog 

razmišljanja. Dostupan je besplatno svim profesorima i đacima ove tri škole i nije na 

prodaju. Pored toga, korišćenje ovog priručnika u svrhu zarade je strogo zabranjeno. 

 

Godina izdanja 2025. 
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Deo1 1: Sve o 3D štampi  

Uvodni deo 
 

Cilj dela priručnika „Korak po korak u 3D štampanju“ je, prvo, da se prikaže evolucija 

3D štampanja, a zatim da se analizira proces proizvodnje i rada 3D štampača. To znači da 

ovaj deo priručnika ima za cilj da objasni kako je tehnologija 3D štampanja evoluirala 

tokom vremena, istovremeno pružajući detalje o tome kako se 3D štampači prave i kako 

funkcionišu. Očekuje se da će ova analiza obuhvatiti tehničke karakteristike, procese i 

izazove u vezi sa njihovim radom. 

Štaviše, ovde će se istražiti moderne primene 3D štampanja u industriji. Izraz „brojne 

moderne primene“ podrazumeva da se 3D štampa koristi u mnogim sektorima industrije, 

a ova raznovrsnost aplikacija će biti predstavljena kako bi se razumela širina i značaj ove 

tehnologije u praksi. 

Ukratko, ovaj deo priručnika se bavi teorijskim i praktičnim aspektima 3D štampanja, 

od njegovog istorijskog razvoja do njegove tehnologije i primene u savremenom 

industrijskom sektoru. 

 

1. Šta je 3D štampa i kako funkcioniše?   
 

3D štampa (ili aditivna proizvodnja) je tehnologija koja omogućava kreiranje fizičkih 

objekata iz digitalnih datoteka dodavanjem materijala sloj po sloj. Za razliku od 

tradicionalnih metoda proizvodnje, kao što je sečenje ili oduzimanje materijala, 3D 

štampa gradi predmet sa preciznim dimenzijama i geometrijskom preciznošću, nudeći 

fleksibilnost i mogućnost kreiranja složenih dizajna. Ova tehnologija se koristi u 

različitim oblastima, omogućavajući proizvodnju delova, modela, protetika i drugih 

proizvoda sa povećanom preciznošću i prilagođavajući se potrebama korisnika. 
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1.1. Istorijski prikaz 3D s tampe 
 

• 1986. Čarls Hal je razvio prvu komercijalnu mašinu za 3D štampanje. 

• 1993. godine MIT je dobio patent za tehnologiju 3D štampanja. 

• Američka kompanija ZCorp je 1995. godine dobila ekskluzivnu licencu 

Masačusetskog tehnološkog instituta i razvila 3D štampače. 

• ZCorp je 2005. godine uspešno razvio Spectrum Z510, prvi 3D štampač u boji 

visoke definicije. 

• U novembru 2010. Urbee, prvi automobil na svetu odštampan 3D štampačem. 

• 6. juna 2011. objavljen je prvi 3D štampani bikini na svetu. 

• U julu 2011. britanski istraživači razvili su prvi svetski 3D čokoladni štampač. 

• U avgustu 2011. inženjeri na Univerzitetu Sautempton razvili su prvi 3D štampani 

avion na svetu. 

• U novembru 2012. godine, škotski naučnici su prvi put koristili ljudske ćelije za 

štampanje veštačkog tkiva jetre pomoću 3D štampača. 

• U novembru 2013. SolidConcepts, kompanija za 3D štampanje iz Ostina, Teksas, 

dizajnirala je i proizvela metalni pištolj odštampan na 3D štampaču. 

• Švedska kompanija Cellink je 2015. godine predstavila prvo standardizovano 

komercijalno bio-mastilo na tržištu, napravljeno od neceluloznog alginatnog 

materijala dobijenog od morskih algi. 

• 2016. godine izašao je Ultimaker 3, koji je osvojio više nagrada kao najbolji 3D 

štampač. 

• U godinama 2017-2018 razvijeni su 3D štampači koji koriste beton i staklo kao 

materijale. 

• U godinama koje su usledile, razvoj tehnologije 3D štampača je bio brz. Danas 

postoji preko 170 proizvođača sistema za 3D štampanje širom sveta. Ova lista 

uključuje: 3D sisteme, Stratasis, Fusion3, Formlabs, Desktop Metal, Prusa i Vokel8, i 

mnoge druge. 
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1.2   Kako radi 3D? 

 
Osnovni ciklus rada 3D štampača uključuje sledeće korake: 

 

1. Dizajniranje modela: Prvi korak je kreiranje digitalnog 3D modela predmeta koji 

želite da odštampate, koristeći program za dizajn. 

 

2. Priprema modela: 3D model se 'seče' na tanke horizontalne slojeve, ovaj proces 

se naziva "rezanjem". Svaki sloj se zatim pretvara u kod pogodan za štampač. 

 

1. Štampanje: Tokom procesa štampanja, štampač koristi materijal, obično plastiku, 

koji se topi i deponuje na željenoj lokaciji svakog sloja. Štampač se pomera duž 

dve ose (Ks i I) da bi postavio materijal na određene pozicije, dok se ploča za 

štampanje pomera svaki put kada se sloj završi (Z osa). 

2.  Sloj po sloj: Štampač ponavlja proces nanošenja slojeva i štampanja za svaki sloj 

dok konačna verzija predmeta ne bude završena. Mogućnost aditivne proizvodnje 

omogućava stvaranje složenih geometrijskih oblika i unutrašnjih struktura. 

Slika 1: Razvoj 3D štampe 
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3. Hlađenje: Kada se štampanje završi, predmet se hladi. Nakon toga, može biti 

potrebna neka naknadna obrada, kao što je uklanjanje ostataka ili nanošenje boje, 

da bi se postigao željeni estetski rezultat. 

 

 

 

 

Slika 2: Proces dizajniranja predmeta 

 

1.3   Komponente 3D štampača 
 

Za rad 3D štampača potrebne su određene bitne komponente i on mora imati neophodnu 

opremu. Lista ovih komponenti može da varira u zavisnosti od tipa 3D štampača, ali sve 

one imaju sledeće osnovne elemente. 

Ekstruder: Glava za štampanje je odgovorna za rukovanje materijalom (kao što je 

plastika ili metal) i njegovo odlaganje u 3D prostor. Neki štampači koriste više glava za 

štampanje sa više boja ili otiske sa različitim materijalima. 
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Slika 3: Eksperimentalni ekstruder 3D štampača  

(Izvor: Potencijali recikliranog PLA u 3D štampi: Osvrt: Mohammad Raquibul Hasan a,, Ian J. Davies b…) 

Radna površina: Radna površina je površina na kojoj se predmet izliva sloj po sloj. Neke 

radne površine se zagrevaju da bi se poboljšala adhezija materijala. 

 

 

Slika 4: Radna površina 3D štampača 
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Sistem osovina: Pokretne ose omogućavaju štampaču da se kreće u različitim pravcima. 

Obično postoje tri glavne ose: X, Y i Z. X i Y ose su odgovorne za kretanje glave 

štampača, dok Z osa podešava visinu glave tokom štampanja. 

 

Filament: Materijal za štampanje je obično u obliku kalema u različitim bojama i može 

uključivati različite materijale, o čemu će se detaljno govoriti u odeljku 2.5 ovog 

poglavlja. 

 

 

 

Slika 5: Filamenti za 3D štampače 

(Izvor: https://3pitech.com/cdn/shop/products/3D-Filament-Family.jpg?v=1686258344) 

Sistem za uvlačenje filamenta: Plastična cev prenosi materijal za štampanje sa kalema 

na glavu štampača. Obično ovo uključuje mehanizam za štampanje, poznat kao ekstruder, 

koji unosi materijal u glavu štampača. 

 

Matična ploča: 3D štampači zahtevaju kontrolni sistem i računar da bi dobili uputstva za 

štampanje.  

 

Kontrolni softver: Kontrolni softver je odgovoran za pretvaranje 3D modela u komande 

koje štampač razume. Takođe pruža opcije podešavanja za parametre kao što su brzina 

štampanja, temperatura i drugi. Kontrolni softver se razlikuje u zavisnosti od proizvođača 

i modela 3D štampača. 
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1.4   Materijali za štampu 
 

Materijal za štampanje, ili filament, je primarni materijal koji se koristi u 3D štampaču za 

kreiranje predmeta. Postoje različite vrste materijala za štampu, a izbor zavisi od zahteva 

projekta i želje korisnika. 

PLA (polilaktična kiselina): 

Karakteristike: PLA je ekološki prihvatljiv, proizveden od biljnog materijala (obično od 

kukuruza) i biorazgradiv. Pogodan je za štampanje predmeta koji ne zahtevaju otpornost 

na visoke temperature. 

Upotreba: Razne primene, kao što su izrada ukrasnih predmeta, igračaka i prototipovi. 

ABS (akrilonitril-butadien-stiren): 

Karakteristike: ABS je jak i izdržljiv, sa dobrom otpornošću na visoke temperature. 

Upotreba: Funkcionalni predmeti, aplikacije koje zahtevaju izdržljivost i otpornost na 

toplotu. 

PETG (polietilen tereftalat glikol): 

Karakteristike: PETG je kombinacija transparentnosti PET-a sa čvrstoćom ABS-a. To je 

izdržljiv i fleksibilan materijal. 

Upotreba: Funkcionalni predmeti, flaše, zaštitne futrole. 

Najlon: 

Karakteristike: Najlon je lagan, izdržljiv i veoma lako upija. Zahteva posebnu pripremu 

za štampanje. 

Upotreba: Preporučuje se za primene koje zahtevaju otpornost na habanje i izuzetnu 

čvrstoću. 

TPE (termoplastični elastomer): 

Karakteristike: TPE je fleksibilan, elastičan i veoma otporan na udarce. Pogodan je za 

otiske koji zahtevaju elastičnost. 

Upotreba: Obično se koristi za pravljenje gumenih predmeta, kao što su gume i zaptivke. 

 

 

Keramički materijali 

Da bi se postigao aditivni metod korišćenjem keramičkih materijala, mora se koristiti 3D 

štampač prilagođen specifičnom zadatku. 
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Štampanje keramičkih materijala se uglavnom vrši korišćenjem četiri tehnologije: 

modeliranje fuzionog taloženja (FDM), fuzija u prahu, selektivno lasersko sinterovanje i 

fotopolimerizacija. 

FDM metoda za štampanje keramičkih materijala zahteva specijalizovane štampače koji 

se napajaju glinom u tečnom stanju, koja se ekstrudira pomoću odgovarajućeg mehanizma 

pritiska. Primena ove metode zahteva dva dodatna koraka u poređenju sa tradicionalnom 

metodom koja koristi polimere. Konkretno, potrebna je odgovarajuća predobrada gline 

pre ekstruzije, kao i naknadna obrada finalnog komada, koja podrazumeva pečenje 

finalnog proizvoda u peći za očvršćavanje. Naknadna obrada se odnosi i na druge metode 

štampanja. Stoga je glavno ograničenje primene 3D štampanja keramike cena 

specijalizovanih štampača i potreba peći. 

 

 

 

 

Slika 6:  Keramički predmeti napravljeni uz pomoć 3D štampača. 
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Pre kupovine filamenta, uvek uzmite u obzir sledeće: 

1. Svojstva materijala 

Jedan od najvažnijih faktora koji treba uzeti u obzir pri izboru pravog filamenta su 

svojstva materijala. Njegove mehaničke, termičke i hemijske karakteristike određuju 

performanse i pogodnost objekta koji ćete kreirati za njegovu predviđenu primenu. 

 

2.Boja i završna obrada 

Boja i završna obrada filamenta su takođe važni faktori koje treba uzeti u obzir. Filamenti 

su dostupni u širokom spektru boja i završnih obrada, od neprozirnih i providnih, do 

metalik. Razmotrite željenu estetiku vašeg projekta i izaberite filament koji će naglasiti 

izgled koji zamišljate i koji želite za vaš predmet. 

  

3.Proizvođač i kvalitet  

Izaberite pouzdanog proizvođača visokokvalitetnih filamenata. Filament nižeg kvaliteta 

može dovesti do lošeg kvaliteta štampe, začepljenja mlaznica, neželjenog odvajanja i 

mnogih drugih problema. 

 

4. Kompatibilnost sa vašim štampačem  

Neki štampači mogu biti kompatibilni samo sa određenim materijalima ili zahtevaju 

specijalizovanu nadogradnju hardvera za štampanje određenih filamenata. 

Pored toga, neki materijali mogu zahtevati određeni prečnik mlaznice ili prilagođavanje 

brzine štampanja. Obavezno istražite kompatibilnost filamenta sa vašim štampačem pre 

kupovine. 

 

2. 3D programi za dizajn 
 

Dizajn i vizuelizacija trodimenzionalnih predmeta je posebna kategorija grafike koja 

obično za ciljnu grupu ima grafičke dizajnere. Međutim, to ne znači da običan korisnik ne 

može da radi sa njima, pod uslovom da imaju neko osnovno znanje o predmetu i volju da 

uče. 
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Programi za 3D dizajn su osnovni alat za profesionalne dizajnere, arhitekte, inženjere i 

uopšte za svakoga ko treba da radi sa takvim aplikacijama. Napredna 3D tehnologija nam 

omogućava da kreiramo realistične vizuelizacije, razvijamo originalne ideje i jasno i 

precizno komuniciramo naše kreacije. 

U današnjem svetu, gde se tehnologija brzo razvija, postoji mnoštvo besplatnih 3D 

programa sa odličnim karakteristikama koji dolaze bez visokih troškova ili 

komplikovanih načina učenja. Ovi alati se sastoje od visokokvalitetnog softvera koji 

korisnicima omogućava da izraze svoju kreativnost i kreiraju impresivna dela. 

Ovde ćemo pomenuti neke od najboljih besplatnih programa za 3D dizajn i modeliranje 

dostupnih široj javnosti. Svaki od njih nudi jedinstvene karakteristike i alate koji mogu da 

zadovolje potrebe i očekivanja svojih korisnika. 

Od aplikacija koje su idealne za početnike, studente i amaterske entuzijaste tehnologije do 

naprednih programa namenjenih profesionalcima, ova lista pokriva širok spektar potreba, 

naglašavajući mogućnosti i performanse svake od njih. 

 

 

 

2.1 Sweet Home 3D 
 

Sveet Home 3D je namenjen onima koji žele da sami dizajniraju svoje sobe u kući. Pruža 

vam mogućnost da kreirate zidove vaših soba, menjate njihove boje, dimenzije i dodajete 

nameštaj. Takođe možete da uvezete 3D modele koje ste kreirali ili da pronađete 

odgovarajuće na različitim veb lokacijama, promenite veličinu i orijentišete svaki komad 

nameštaja i istovremeno vidite promene u dizajnu u 3D prikazu. Pored toga, možete 

odštampati dizajn. 

Zvaničan veb-sajt: https://www.sweethome3d.com/ 

 

 

https://www.sweethome3d.com/
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Slika 7: Sweet Home Softver  

(Izvor:https://encryptedtbn1.gstatic.com/images?q=tbn:ANd9GcSNF2fPcgxESyfQw3Qt52K5lPxsCcHqyVJ

E2zdKG9TeeNbKe50t) 

 

2.2 DreamPlan Home Design Software 
 

Vaš dom iz snova može biti dizajniran i vizualizovan realističnim trodimenzionalnim 

modelom. Dizajnirajte pod svog prostora i prilagodite boje, teksture, nameštaj i bilo šta 

drugo što možete zamisliti da biste kreirali prostor koji u potpunosti zadovoljava vaše 

potrebe i estetiku. 

Softver vam omogućava da prelazite između 3D i 2D režima gledanja da biste usavršili 

pod, koristili funkciju skeniranja, iskoristili postojeće dizajne iz obezbeđenih biblioteka, 

dizajnirali spoljašnje prostore (npr. dvorišta, bašte, garaže) i mnoge druge funkcije. 

Softver nije na mreži; zahteva instalaciju na vašem računaru. Besplatnu verziju možete 

preuzeti sa sledećeg linka.  

https://www.nchsoftware.com/design/designsetup.exe  

Nije potrebna registracija. 

 

 

 

https://www.nchsoftware.com/design/designsetup.exe
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Slika 8:  DreamPlan Home Design Softver 

(Izvor: https://www.nchsoftware.com/design/images/webp/kitchen4.webp) 

 

2.3 TinkerCAD 
 

   Tinkercad je besplatni onlajn program za 3D modeliranje koji radi u veb pretraživaču, 

poznat po svojoj jednostavnosti i lakoći korišćenja. Zbog ovih karakteristika brzo je 

postao popularan u školama. Nastavnici širom sveta koriste Tinkercad da pomognu 

studentima da se upoznaju sa 3D dizajnom pre nego što prođu obuku softvera za 

profesionalnu upotrebu. Iako je idealan za početnike, to ne znači da iskusniji korisnici ne 

mogu da ga koriste za kreiranje impresivnih modela.  

Tinkercad je dostupan na mreži, a da biste ga koristili, jednostavno morate da otvorite 

nalog. Proces je brz i lak, prateći korake prikazane na ekranu. 

Možete uživati u funkcijama TinkerCAD-a na sledećem linku: 

   https://www.tinkercad.com/join  

 

 

 

 

 

 

 

 

 

Slika 9: TinkerCAD 
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2.4 FreeCAD 
  

FreeCAD je parametarski alat za 3D modeliranje zasnovan na funkcijama za opštu 

upotrebu u CAD, MCAD, CAk, CAE i PLM. Prvenstveno je namenjen inženjeringu i 

dizajnu proizvoda, ali se takođe uklapa u širok spektar inženjerskih aplikacija, kao što su 

arhitektura i druge inženjerske specijalnosti. On je 100% otvorenog koda i veoma 

modularan, što omogućava napredno proširenje i prilagođavanje. 

Njegova jednostavnost učinila ga je prilično popularnim u školama, gde se uglavnom 

koristi u stručnom obrazovanju, približavajući učenicima profesionalni dizajn. 

Poglavlja 1 i 2 ovog priručnika fokusiraju se na učenje FreeCAD softvera. 

 

 

2.5 Onshape 

 

Onshape je softver za projektovanje pomoću računara (CAD), koji se isporučuje preko 

interneta koristeći model softvera kao usluge (SaaS). U velikoj meri koristi rad u oblaku, 

sa obradom i prikazivanjem koji zahtevaju veliku računarsku snagu na serverima 

zasnovanim na Internetu, dok korisnici mogu da komuniciraju sa sistemom preko veb 

pretraživača ili preko iOS i Android aplikacija. Kao SaaS sistem, Onshape ažuriranja se 

objavljuju direktno na veb interfejsu, a softver ne zahteva održavanje od strane korisnika. 

Prilično ga je lako naučiti i veoma je sličan po funkcionalnost i rukovanju sa FreeCAD-

om. Njegova glavna prednost je sposobnost samoučenja. Kroz niz lekcija koje pruža sam 

program, korisnici, čak i potpuni početnici, imaju priliku da sami počnu i razviju se u 

sposobne dizajnere. Po završetku kurseva, korisnik može po niskoj ceni odštampati 

sertifikat, što ga odmah kvalifikuje kao profesionalnog dizajnera i omogućava mu ulazak 

na tržište rada. 

Možete kreirati nalog na sledećem linku:  https://www.onshape.com/en/products/free  

 

 

https://www.onshape.com/en/products/free
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Slika 10: Certified Onshape Professional  

(Izvor:https://d36ai2hkxl16us.cloudfront.net/thoughtindustries/image/upload/a_exif,c_fill,w_800,h_450/v1/

course-uploads/6e557ed6-d03d-4c48-9492-4d18d145d7a1/tkifcukd7h2d-certprobadge800x450-01.png) 

 

2.6 Make Human 

 

MakeHuman je softver otvorenog koda za kreiranje 3D modela ljudskih likova.  

Prvenstveno se fokusira na brzo i lako kreiranje prilagođenih ljudskih oblika, koji se 

mogu koristiti u različite svrhe, kao što su 3D modeliranje, grafika, igre, filmovi i naučna 

istraživanja. 

Omogućava korisnicima da menjaju parametre kao što su pol, starost, etnička pripadnost, 

oblik tela i crte lica. Pored toga, omogućava izbor i primenu različite odeće, frizura, 

dodataka i stilova za modele. 

Kreirani modeli se mogu eksportovati sa potpuno prilagođenim skeletnim sistemom. 

Takođe podržava izvoz modela u popularnim formatima datoteka kao što su OBJ, FBKS, 

DAE i STL, što ih čini kompatibilnim sa drugim softverom za dizajn i 3D uređivanje radi 

daljeg usavršavanja predmeta. Njegov interfejs prilagođen korisniku omogućava brzo 

prilagođavanje modela bez potrebe za posebnim znanjem. 

Dostupan je za Windovs i Mac OS X. Da biste pokrenuli aplikaciju, nakon preuzimanja 

datoteke, raspakujte je i pokrenite izvršnu datoteku „makehuman“. 

Aplikaciju možete preuzeti sa sledećeg linka: 



Step by Step in 3D printing 

 

 

18 

 

https://makehuman.en.softonic.com/  

 

 

Slika 11: MakeHuman Softver 

(Izvor: https://www.studiorola.com/wp-content/uploads/2014/07/makehuman.jpg) 

 

2.7 Carbide Create 
 

Kombinujte snagu 2D dizajna i uređivanja sa 3D simulacijom i gledajte kako vaši dizajni 

postaju realnost. Carbide Create, koji je razvio Carbide 3D, dizajniran je da pojednostavi 

kreiranje i proizvodnju 2D i 3D objekata za CNC mašine. Posebno je popularan među 

početnicima i iskusnim korisnicima koji rade sa CNC mašinama za sečenje i graviranje 

projekata, a idealan je i za one koji se bave 3D štampanjem. 

 

Carbide Create je softver za preuzimanje kompatibilan sa Windovs-om i macOS. Još 

bitnije, to je jedini CAD/CAM softver na više platformi koji se ne oslanja na „Oblak“. Što 

je najvažnije, nudi se besplatno — ne samo Carbide 3D kupcima, već i svima. 

Da biste mu pristupili, potrebna je registracija. Kada se registrujete, dobićete e-poruku 

koja sadrži vezu za preuzimanje softvera, zajedno sa video zapisima sa objašnjenjima koji 

će vas voditi kroz njegovu upotrebu. 

 Zvanični link: https://carbide3d.com/  

 

https://makehuman.en.softonic.com/
https://carbide3d.com/
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Slika 12: Carbide Create Software  

(Izvor: https://carbide3d.com/images/blog/cc620.png) 

 

2.8 Blender 

 

Jedan od najboljih besplatnih programa za kreiranje 3D predmeta. Koristi se za 3D 

modeliranje, nudeći alate za kreiranje i uređivanje složenih 3D predmeta sa 

karakteristikama kao što su poligonalno modeliranje, vajanje i modeliranje površine. 

Podržava animaciju karaktera i predmeta kroz napredne alate za animaciju i montiranje. 

Uključuje moćni Cicles mehanizam za renderovanje, kao i Eevee, mehanizam za 

renderovanje u realnom vremenu koji daje rezultate visokog kvaliteta. Takođe ima 

integrisani video editor koji omogućava rezanje, dodavanje efekata i upravljanje zvukom. 

Pored toga, podržava kreiranje vizuelnih efekata i praćenje pokreta, što ga čini idealnim 

za upotrebu u filmskoj industriji. Dostupan je za sve glavne operativne sisteme, 

uključujući Windows, Linux, and macOS. 

 

Zvanični link: https://www.blender.org/  

 

 

https://carbide3d.com/images/blog/cc620.png
https://www.blender.org/
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Slika 13: Blender Softver  

(Izvor :https://miro.medium.com/v2/resize:fit:720/format:webp/1*kHCirek7ELBS_tfulA_agg.jpeg) 

 

2.9 Potter Draw 
 

PotterDraw je besplatni softver za dizajn koji omogućava kreiranje 3D keramičkih 

predmeta i posuda kroz intuitivan i kreativan interfejs. Prvenstveno cilja na korisnike koji 

žele da dizajniraju i prilagođavaju keramičke uzorke bez prethodnog iskustva sa CAD ili 

softverom za 3D modeliranje. 

PotterDraw se zasniva na upotrebi rotaciono simetričnih oblika. Korisnici mogu da 

kreiraju profil, a softver ga automatski transformiše u 3D predmet. Dizajni se mogu 

izvoziti u formate datoteka kao što je STL, pogodan za upotrebu sa 3D štampačima. 

Takođe omogućava primenu materijala, boja i tekstura na objekte za simulaciju 

keramičkih površina. 

Softver je kompatibilan sa Windows sistemima i nudi se besplatno, što ga čini dostupnim 

amaterskim stvaraocima i hobistima. 

Zbog svoje prirode prilagođene korisniku, PotterDraw se često koristi u obrazovne svrhe, 

omogućavajući studentima i početnicima da eksperimentišu sa umetnošću keramike i 3D 

dizajna. 
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Aplikaciju možete preuzeti sa sledećeg linka: 

https://potterdraw.sourceforge.io/download.html  

 

 

 

Slika 14: PotterDraw Softver  

(Izvor:https://i.all3dp.com/workers/images/fit=scaledown,w=1536,h=864,gravity=0.5x0.5,format=auto/wp

-content/uploads/2017/08/27005927/PotterDraw-screenshot.png) 

 

  2.10 Model Air Design 

 

Model Air Design je besplatna, besplatna aplikacija dizajnirana za kreiranje 3D modela 

aviona. To je odličan alat za hobiste i one koji su zainteresovani za dizajniranje modela 

aviona bez potrebe za naprednim CAD softverskim veštinama. Softver obezbeđuje 

šablone i uputstva korak po korak za projektovanje raznih komponenti aviona, kao što su 

trup, krila, motori i točkovi. Možete birati između različitih unapred definisanih dizajna i 

prilagoditi njihovu veličinu, položaj i druge karakteristike. 

Model Air Design ima intuitivan interfejs koji pojednostavljuje proces modeliranja, čineći 

ga dostupnim početnicima, a istovremeno nudi dovoljno fleksibilnosti za iskusnije 

korisnike. Program vam omogućava da pregledate svoje dizajne u 3D, rotirajući ih u svim 

pravcima, pa čak i simulira osnovno ponašanje leta kako bi vam dao osećaj kako će vaš 

https://potterdraw.sourceforge.io/download.html
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model raditi. Takođe uključuje opcije prilagođavanja za boje, šare i druge elemente 

dizajna. 

Ovaj alat je pogodan i za kreatore fizičkih modela i za one koji jednostavno žele da istraže 

umetnost dizajna aviona digitalno. Model Air Design je dostupan za Windows i može se 

besplatno preuzeti. 

Zvanični link: https://modelairdesign.com/  

 

 

Slika 15: Model Air Design Softver  

(Izvor: https://www.majorgeeks.com) 

 

  2.11 Wings 3D 
 

Wings 3D je besplatan softver za 3D modeliranje otvorenog koda specijalizovan za 

modeliranje zasnovano na poligonima. Dizajniran je tako da bude lak za upotrebu, nudeći 

radni prostor fokusiran na jednostavnost i upotrebljivost. Istovremeno, pruža moćne alate 

koji olakšavaju kreiranje 3D modela, što ga čini idealnim za umetnike i dizajnere koji 

traže alat lak za korišćenje sa dobro organizovanim načinom rada. 

Softver pruža osnovnu podršku za primenu materijala i mapiranje (preslikavanje) 

teksture, omogućavajući korisnicima da pripreme svoje modele za specijalizovaniju 

primenu. Iako ne uključuje napredne alate za renderovanje, podržava integraciju sa 

https://modelairdesign.com/
https://www.majorgeeks.com/
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drugim 3D softverom kroz izvoz u različite formate datoteka. Wings 3D je napisan u 

Erlang programskom jeziku, poznatom po svojoj pouzdanosti, i dostupan je za Windows, 

macOS i Linux, pokrivajući sve glavne platforme. 

Jedna od ključnih prednosti Wings 3D je ta što je lagan i brz za upotrebu. Idealan je za 

početnike koji žele da nauče osnove 3D modeliranja, dok njegova jednostavnost olakšava 

učenje. Međutim, softver takođe ima neka ograničenja. Ne uključuje ugrađene alate za 

renderovanje ili animaciju, jer se fokusira isključivo na modeliranje. Pored toga, nedostaju 

mu napredne funkcije kao što su proceduralno modelovanje ili vajanje, koje bi bile 

korisne za kreiranje zahtevnijih modela. 

Sve u svemu, Wings 3D je odličan izbor za umetnike i kreatore koji žele da dizajniraju 

modele niske do srednje složenosti. Pogodan je za upotrebu u igrama, simulacijama ili 

drugim 3D aplikacijama, pružajući osnovne alate za efikasan i kreativan rad. 

Aplikaciju možete preuzeti sa sledećeg linka: 

https://www.wings3d.com/download-2/  

 

 

Slika 16: The Wings 3D Softver  

(Izvor: https://www.tromjaro.com/wp-content/uploads/2020/03/wings3d-14.png) 

Lista je obimna i nemoguće je dokumentovati sve programe za 3D dizajn u ovom 

priručniku. Međutim, oni koji su zainteresovani mogu dalje da istraže i otkriju mnoštvo 

alata i aplikacija koje će zadovoljiti njihove potrebe i želje. 

 

Najnovija dostignuća u tehnologiji omogućavaju štampanje trodimenzionalnih predmeta 

bez prethodnog procesa dizajniranja. Ovo se postiže upotrebom 3D skenera.  

3D skeniranje je proces snimanja trodimenzionalnih predmeta ili okruženja pomoću 

specijalizovanih sistema ili uređaja koji mogu da otkriju i zabeleže njihovu geometriju i 

https://www.wings3d.com/download-2/
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izgled u tri dimenzije. Ova tehnika je korisna u mnogim oblastima, kao što su industrija, 

arhitektura, arheologija, medicina i umetnost. 

Postoje različiti načini za izvođenje ovog procesa, uključujući upotrebu lasera, fotografije 

ili čak senzora koji opažaju udaljenost i oblik predmeta. Napredne tehnike se često koriste 

za kreiranje digitalnih modela koji se mogu koristiti za analizu, dizajn, dokumentaciju ili 

čak reprodukciju predmeta. 

 

 

 

slika 17: 3D Skener 
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3. Prednosti i mane 3D štampe 
 

   Kao što svako tehnološko dostignuće ima pozitivne i negativne strane, tako i tehnologija 

3D štampe, koja, iako ima nekoliko prednosti, ima i relativno značajan broj nedostataka. 

Kao primer navodimo sledeće prednosti i mane. 

 

3.1 Prednosti 
 

1. Manjak aktivnosti koje stvaraju novu vrednost:  

Vrednost finalnog proizvoda se ne povećava značajno sa svakom sledećom fazom u 

proizvodnji, kao što je uobičajeno u tradicionalnim postupcima proizvodnje. Kraći 

proizvodni lanac za izradu 3D predmeta.  

2. Smanjenje troškova u procesu proizvodnje:  

Ovo se dešava prvenstveno zbog cene materijala. Sirovine koje se koriste je lako pronaći i 

prilično su pristupačne. Nema potrebe za velikim proizvodnim lancima, jer su jedini 

potrebni alati štampač i računar. 

3. Direktan kontakt između proizvođača i potrošača: 

 Zbog jedinstvene prirode ove tehnologije, interakcija između potrošača i proizvođača je 

direktnija nego u tradicionalnom proizvodnom lancu. Ovde potencijalni kupci biraju 

artikal za štampanje i odmah kontaktiraju kompaniju, koja zatim prosleđuje porudžbinu 

dizajneru i pokreće proces kreiranja. 

4. Manji broj proizvoda na zalihama:  

Ključna karakteristika 3D štampanja je proizvodnja na zahtev. Zbog toga nema fizičkih 

prodavnica, a samim tim ni zaliha u magacinima. 

5. Manje složenosti u proizvodnom procesu: 

Ne postoji mnogo različitih mašina koje bi mogle stvoriti zabunu u proizvodnom procesu. 

Koraci su jednostavni i svaki put se prate na isti način. 

6. Predmeti se mogu lako menjati:  

Kada kreirate predmet u digitalnoj datoteci, lako je izvršiti modifikacije, čak i kada je 

predmet u završnoj fazi projektovanja. 
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7. Brži proces proizvodnje:  

Nema potrebe za velikim količinama porudžbina da bi se pokrenula proizvodnja 

predmeta, što proces čini jednostavnijim i bržim u poređenju sa tradicionalnim metodama 

proizvodnje. 

8. Lakša replikacija i redizajn proizvoda: 

Digitalne datoteke se čuvaju u bazama podataka nakon završetka proizvodnje, što čini 

redizajn objekta veoma jednostavnim procesom. 

9. Raznovrsnost u proizvodnji predmeta različitih oblika:  

3D štampač može da kreira predmete sa mnogo različitih oblika svaki put kada štampa. 

Tradicionalne mašine su manje fleksibilne i imaju ograničeniji opseg formacija. 

 

3.2 Mane 
 

1. Visoki troškovi nabavke opreme:  

Nabavne cene 3D štampača koji se koriste u profesionalne svrhe su prilično visoke. Oni 

počinju od 500 evra za mala preduzeća sa ograničenom proizvodnjom i mogu da dođu do 

10.000 evra. Ove cene se stalno menjaju kako se tehnologija 3D štampanja razvija. 

2. Procesi koji se ponavljaju do savršenstva predmeta:  

Sposobnost dizajnera da uređuje digitalnu datoteku u bilo kojoj fazi, na osnovu 

preferencija klijenta, je nešto što se obično ne nalazi u tradicionalnim proizvodnim 

lancima. Međutim, to ponekad može uzrokovati kašnjenje u kreiranju predmeta i može 

rezultirati ponavljanjem istih procesa više od dva puta. 

3. Male proizvodne količine:  

U velikom proizvodnom lancu moguće je istovremeno proizvoditi velike količine. To nije 

slučaj sa 3D proizvodnjom. Ovde, ako je predmet veliki, kreira se samo jedan proizvod u 

jednom trenutku, sa trajanjem od jednog sata do 5-6 sati, u zavisnosti od brzine štampača. 

Iako je tehnologija napredovala, a postoje štampači koji mogu istovremeno da štampaju 

nekoliko modela, još uvek nisu dostignute  količine koje se proizvode tradicionalnim 

metodama proizvodnje. 

4. Nemogućnost proizvodnje velikih delova predmeta:  
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5. Većina 3D štampača, posebno onih dizajniranih za kućnu upotrebu, mogu da 

štampaju proizvode do određene veličine, obično ne mnogo veće od njihovih dimenzija. U 

industriji 3D štampanja, veliki predmeti se štampaju u delovima, a zatim sklapaju. 

6. Zaštita intelektualne svojine:  

Prisustvo onlajn prodavnica za naručivanje različitih predmeta primorava većinu 

kompanija da izlože artikle koje dizajniraju na različitim onlajn platformama. Kao rezultat 

toga, lični podaci dizajnera nisu zaštićeni. Jednostavno rečeno, intelektualna svojina 

predmeta nije obezbeđena. 

7. Nedostatak prodavnica:  

So far, stores selling products derived from 3D printing are exclusively online. This 

presents the disadvantage of limited awareness among potential consumers. However, 

from a professional perspective, this can be seen as an advantage, as it reduces the 

expenses associated with operating a physical store. 

Do sada su prodavnice koje prodaju proizvode proizvedene 3D štampom bile uglavnom 

onlajn. Ovde nedostatak predstavlja ograničenja svesti među potencijalnim potrošačima. 

Međutim, iz profesionalne perspektive, ovo se može posmatrati kao prednost, jer smanjuje 

troškove vezane za rad fizičke prodavnice. 

8. Visoka potrošnja energije: 

Godine 2009. Masačusetski institut za tehnologiju (MIT) sproveo je istraživanje o 

potrošnji električne energije tehnologijom fuzije metalnog praha i otkriveno je da ona 

koristi stotinu puta više energije od tradicionalnog livenja ili obrade metala. Zbog toga su 

3D štampači pogodniji za proizvodnju malih serija. 

 

4. 3D štampa u industriji 
 

   Aditivna proizvodnja (3D štampa) našla je primenu u mnogim industrijskim sektorima, 

nudeći nove mogućnosti i poboljšanja u proizvodnim procesima. Od automobilske i 

vazduhoplovne industrije, gde se koristi za proizvodnju visoko preciznih i lakih 

komponenti, do oblasti medicine, gde se koristi za kreiranje personalizovanih protetika i 

medicinskih uređaja, 3D štampa je revolucionirala tradicionalne metode proizvodnje. 

Pored toga, široko se koristi u arhitekturi za proizvodnju modela i u potrošačkoj industriji 
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za kreiranje malih serija proizvoda. Fleksibilnost, tačnost i sposobnost stvaranja složenih 

geometrija učinili su aditivnu proizvodnju ključnim alatom za inovacije i napredak u 

različitim sektorima. 

   Pokušaćemo da analiziramo industrijske sektore u kojima se primenjuje 3D štampa i 

predstavimo što je više moguće praktičnih primena, čak istražujući i polja za koja se u 

početku čini da je nemoguće da će imati koristi od ove tehnologije. 

 

4.1 Vazduhoplovstvo 

 

3D štampa ima mnogo primena u vazduhoplovstvu, značajno doprinoseći evoluciji 

tehnologije i proizvodnih procesa. Koristi se za stvaranje lakih i izdržljivih komponenti, 

smanjujući težinu aviona i svemirskih letelica, što poboljšava efikasnost i energetske 

performanse. Pored toga, 3D štampa omogućava proizvodnju složenih geometrijskih 

dizajna koji nisu mogući tradicionalnim metodama, poboljšavajući performanse motora, 

sistema aviona i strukturnih elemenata svemirskih letelica. Ova tehnologija takođe pruža 

mogućnost brzog izrade prototipa i testiranja, smanjujući vreme i troškove proizvodnje, 

dok nudi veću fleksibilnost u dizajnu i proizvodnji. 

 

 

 

Slika 18: 3D štampa u vazduhoplovstvu 
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(Izvor:https://www.indiaherald.com/cdncgi/image/width=750/imagestore/images/politics/politics_latestnew

s/3d4k-415x250.jpg) 

 

 

4.2 Automobilska industrija 
 

U automobilskoj industriji, tehnologija 3D štampanja nudi mogućnost brze proizvodnje sa 

visokom preciznošću, skraćujući razvojni ciklus i smanjujući troškove proizvodnje. Ove 

prednosti ga čine veoma cenjenim rešenjem među proizvođačima automobila. Štaviše, 

upotreba širokog spektra materijala poboljšava kvalitet vozila, dok se istovremeno 

izbegava velika potrošnja resursa uzrokovana greškama u dizajnu i smanjuje zavisnost od 

tradicionalnih metoda proizvodnje zasnovanih na kalupima. 

Primena 3D štampanja u automobilskoj industriji prevazišla je fazu kreiranja 

jednostavnih konceptualnih prototipova i sada se širi na funkcionalne komponente, utičući 

na svaki aspekt proizvodnje delova. 

 

Primene 3D štampanja u automobilskim delovima: 

U procesu razvoja: 

3D štampa ubrzava fazu istraživanja i razvoja omogućavajući brzo kreiranje prototipova i 

testiranje složenih dizajna, štedeći i vreme i resurse. 

 

Proizvodnja složenih konstrukcija i komponenti: 

Olakšava proizvodnju složenih geometrija, laganih struktura i prilagođenih komponenti 

koje ispunjavaju specifične zahteve savremenih vozila. 

 

U proizvodnji kalupa: 

3D štampa poboljšava proces proizvodnje kalupa, skraćujući razvojni ciklus i omogućava 

stvaranje složenih i preciznih dizajna po nižoj ceni i za manje vremena. 

Prvi električni automobil u potpunosti proizveden korišćenjem tehnologije 3D 

štampanja bio je X-EV, koji je razvila kineska kompanija Polimejker, 

specijalizovana za proizvodnju 3D štampanih komponenti. Vozilo sa dva sedišta se 

sastoji od 57 delova, od kojih su skoro svi 3D štampani, osim šasije, prozora i sedišta. 
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Vreme proizvodnje, uključujući i proizvodnju njegovih komponenti, nije bilo duže 

od tri dana. 

 

 

 

4.3 Medicina 
 

Medicina je još jedna naučna oblast koja je imala značajne koristi od prednosti 3D 

štampanja. Ova tehnologija nalazi primenu u opštem medicinskom obrazovanju, hirurškoj 

obuci i obrazovanju pacijenata. Trodimenzionalni ljudski modeli se koriste u nastavi i 

učenju, nudeći učenicima jasnije razumevanje anatomije organa i srodnih bolesti. 

 Istovremeno, 3D snimanje se pokazalo kao dragoceno sredstvo u planiranju i 

izvođenju hirurških zahvata. Kreiranjem personalizovanog 3D modela za svakog 

pacijenta, hirurški timovi mogu precizno proceniti anatomiju pacijenta i dizajnirati 

optimalne hirurške pristupe. Ovo doprinosi efikasnijim i bržim operacijama uz smanjenje 

rizika od komplikacija. Pored toga, ovaj proces minimizira vreme operacije, na kraju 

poboljšavajući ukupan kvalitet medicinske nege. 

 

Slike 19: Prvi 3D štampani auto  

(Izvor:https://encryptedtbn0.gstatic.com/images?q=tbn:ANd9GcS2i3PEPyNkxQSzlALiKy7VFo

4eLBu1lKlw7Q&s 
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 3D štampa se efikasno primenjuje i u oblasti regenerativne medicine koja ima za cilj 

zamenu obolelih tkiva ili organa. Preciznost i ponovljivost tkiva i organa stvorenih 

tehnikama dostupnim pre samo nekoliko godina bilo je teško kontrolisati. 3D štampa je 

kombinovala složenost žvog tkiva sa visokom preciznošću, proizvodeći izuzetno efikasne 

modele. Stvaranje 3D štampanih kožnih tkiva, srčanog tkiva, kostiju, hrskavice i brojnih 

drugih transplantata sada je stvarnost, što dovodi do značajnog napretka u medicini. 

Omogućio je razvoj personalizovanih tretmana, smanjio potrebu za donatorima i 

poboljšao kvalitet života pacijenata. 

 

Slika 20: Proces kreiranja 3D modela čoveka  

(Izvor:https://lens.usercontent.google.com/image?vsrid=CLuR3rzwEQAhgBIiRlYjUxYTU4Zi1jNTg2LT

Q3NGYtOGU1NS0xOGUzMTBkM2E5Njk&gsessionid=PJm0lLqcsj0bIMGvnHJasu8HlnRy2jRwggC8a

KqUfO6uWDULQE39aw 
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Slika 21: Proces dizajniranja 3D modela čoveka  

(Izvor:https://lens.usercontent.google.com/image?vsrid=CNT7l50CEAIYASIkYWMzMjgyNzAtNjU4ZC00O

Tg0LTk2YmEtODg4YzQ3OGJlMmY4&gsessionid=LRm5r_KyqhjiTQn1pCxqSkT2Nu-

OTip9y97bljIZCnD9RPVn2_sjlQ)  

 

Još jedna primena 3D štampe koja je zadobila poverenje javnosti je oblast protetike. 

Asortiman 3D štampanih komponenti, proizvedenih korišćenjem metoda kao što su 

modeliranje organa i fuzija materijala, široko se koristi za zadovoljavanje potreba 

pacijenata u ortopediji, stomatologiji, onkologiji i plastičnoj hirurgiji. Protetski modeli se 

ističu po svojoj preciznosti, prilagođavanju i prilagodljivosti, pružajući rešenja koja 

poboljšavaju funkcionalnost i poboljšavaju kvalitet života pacijenata. 
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4.4 Farmakologija 
 

3D štampa se takođe probila u oblasti farmaceutskih proizvoda. Do 2022. ostao je u 

eksperimentalnoj fazi, ali se sada aktivno koristi, približavajući sektor personalizovanoj 

medicini. 3D štampači proizvode farmaceutske formulacije i omogućavaju prilagođavanje 

oblika pilula i premaza, omogućavajući oslobađanje aktivnih sastojaka prema specifičnim 

potrebama svakog pacijenta. Takođe postoji mogućnost kombinovanja više aktivnih 

sastojaka. Celokupni režim lečenja za pacijenta može da se primeni čak i u obliku jedne 

tablete, u bilo kojoj potrebnoj dozi. 

Glavne prednosti ove tehnologije su jednostavnost upotrebe, neograničene mogućnosti, 

brzina i preciznost u proizvodnji farmaceutskih formulacija. To je takođe ekološki 

prihvatljiva tehnologija i naravno, mnogo isplativija od tradicionalnih metoda proizvodnje 

lekova, jer značajno smanjuje troškove proizvodnje. U pogledu geometrijskih 

karakteristika oralnih lekova, ona nudi prednost promene oblika i veličine prema 

specifičnim potrebama svakog pacijenta. Ova sposobnost je posebno korisna u 

pedijatrijskim i gerijatrijskim lekovima. 

Konačno, direktna proizvodnja farmaceutske formulacije izuzetno je korisna u 

ordinacijama, ambulantama ili kriznim zonama, i kao takva je ključna za upotrebu lekova 

sa kratkim rokom trajanja ili stabilnošću. 

Slika 22: 3D štampanje protetičke ruke 

(Izvor:https://www.google.com/url?sa=i&url=https%3A%2F%2Fwww.jaguar-

kktc.com%2Fabout-jaguar%2Fjag-style%2Fjag-tech%2Fteknoloji-gelecek-geldi-3d-yazicilar-

evimizde&psig=AOvVaw2HyVIRRYOsnfBT-

zlhIXXU&ust=1732906056247000&source=images&cd=vfe&opi=89978449&ved=0CBAQjRxq

FwoTCMDglsza_4kDFQAAAAAdAAAAABAS 
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Slika 23: Proizvodnja farmaceutckih tableta uz pomoć 3D štampača. 

(Izvor: https://www.voria.gr/article/i-trisdiastati-ektiposi-anaschediazi-to-mellon-tis-farmakeftikis) 

 

4.5 Industrija hrane  
 

Iako mnogima može izgledati neverovatno, 3D štampa je našla primenu u oblasti 

prehrambene tehnologije. S obzirom da na izbor potrošača na tržištu hrane utiču 

kriterijumi kao što su ukus, kvalitet i sastojci proizvoda, 3D štampa ispunjava ove zahteve 

omogućavajući kreiranje personalizovanih prehrambenih proizvoda. Ova inovacija je 

posebno korisna za određene grupe potrošača, kao što su deca, starije osobe, pacijenti i 

sportisti, jer prilagođava hranu tako da zadovolji njihove jedinstvene potrebe. Štaviše, 

primene u oblasti upravljanja ishranom su izvanredne, a kompanije je koriste za razvoj 

personalizovanih obroka koji podržavaju ciljeve kao što su gubitak težine ili atletske 

performanse, prilagođene individualnim potrebama svakog kupca. 

Pored mogućnosti stvaranja visokokvalitetnih namirnica sa superiornom nutritivnom 

vrednošću i jedinstvenim ukusima, 3D štampači su uveli umetničku dimenziju u pripremu 

hrane. Kuvari sada imaju priliku da eksperimentišu sa inovativnim dizajnom i zamršenim 

oblicima, podižući lestvicu kreativnosti i estetike u visokoj kuhinji. Istovremeno, sada su 

postignuti rezultati koje je bilo nemoguće postići tradicionalnim metodama, a proces 

pripreme obroka postaje efikasniji i štedi dragoceno vreme. 

Iako 3D štampanje hrane sve više raste i pojavljuje se kao inovativno rešenje u oblasti 

ishrane, ono se i dalje suočava sa izazovom prihvatanja potrošača. Mnogi potrošači su i 
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dalje skeptični prema ovoj novoj tehnologiji, bilo zbog nedostatka informacija ili 

zabrinutosti oko kvaliteta, sigurnosti ili čak prirodnosti štampane hrane. Prevazilaženje 

ove prepreke zahteva veću svest, obrazovanje i poverenje kako bi se osiguralo da 

potencijal ove tehnologije bude široko prihvaćen. 

 

Slika 24:  Digitalna  gastronomija  

(Izvor:https://www.nutri-book.gr/images/article_images/nutri-book-psifiaki-gastronomia-3d-trofima-stin-

ypiresia-tis-diaitologias.jpg) 

 

4.6 Pakovanje 
 

3D štampa je postala vredan saveznik u industriji ambalaže, uvodeći novi način 

projektovanja i proizvodnje koji radikalno transformiše ovu oblast. Jedna od njenih 

najznačajnijih prednosti je mogućnost kreiranja pakovanja prilagođenog potrebama 

potrošača ili proizvoda. Bilo da se radi o inovativnom dizajnu koji odražava identitet 

proizvoda ili funkcionalnom pakovanju koje pruža veću zaštitu njegovog sadržaja, 3D 

štampa nudi preciznost i raznovrsnost materijala za ispunjavanje čak i najzahtevnijih 

želja. Industrija kozmetike i parfema, poznata po naglasku na originalnosti i jedinstvenosti 

ambalaže, jedan je od najjačih zagovornika 3D štampe. Zahvaljujući ovoj tehnologiji, 

kompanije mogu kreirati impresivne dizajne koji se ističu, poboljšavajući identitet i 

luksuz svojih proizvoda. Štaviše, 3D štampa omogućava brz razvoj prototipova i testiranje 

novih ideja, štedeći vreme i resurse, istovremeno omogućavajući proizvodnju malih serija 

za ekskluzivne kolekcije. Na ovaj način pakovanje kozmetike i parfema postaje još 

upečatljivije i prilagođeno željama kupaca. 
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Još jedna značajna prednost 3D štampanja je smanjenje troškova proizvodnje i 

vremena. Tehnologija omogućava brzo stvaranje prototipova, minimizirajući potrebu za 

tradicionalnim kalupima ili proizvodnim procesima velikih razmera. Ovo ne samo da 

ubrzava lansiranje novih proizvoda na tržište, već i smanjuje otpad, jer se štampaju samo 

neophodni delovi. Pored toga, kompanije mogu brzo da prilagode svoju ambalažu kako bi 

odgovorile na tržišne trendove ili zahteve kupaca. 

Održivost je još jedna oblast u kojoj se 3D štampa u ambalaži pokazuje kao izuzetno 

korisna. Korišćenjem ekološki prihvatljivih materijala koji se mogu reciklirati, kompanije 

mogu da smanje svoj ekološki otpad, usklađujući se sa zahtevom za više „zelenih“ 

rešenja. Štaviše, mogućnost štampanja lakše, ali jednako izdržljive ambalaže pomaže u 

smanjenju troškova transporta i potrošnje energije. Dakle, 3D štampa kombinuje 

inovaciju sa održivošću, što je čini jednom od najperspektivnijih tehnologija u industriji 

ambalaže. 

 

 

 

 

 

 

 

 

 

 

Slika 25:  Dizajn parfema na 3D štampaču 

(Izvor:https://icdn.tradew.com/file/202011/1574707/jpg/7467918.jpg?x-oss-

process=image/quality,Q_90/format,webp) 
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4.7 Arhitektura i građevina 
 

Arhitekte su bile prve koje su koristile 3D štampanje u građevinskoj industriji, 

koristeći tehnologiju za kreiranje impresivnih i preciznih modela zgrada. Sa mogućnošću 

štampanja 3D dizajna i modela, arhitektonski dizajn je značajno evoluirao, omogućavajući 

profesionalcima da predstave svoje projekte sa većom preciznošću i detaljima, a 

istovremeno nudeći klijentima sveobuhvatniji pogled na konačni rezultat. 

3D štampa je omogućila arhitektama da eksperimentišu sa složenijim i smelijim 

arhitektonskim formama koje bi bilo teško postići tradicionalnim metodama. Sposobnost 

stvaranja zamršenih geometrija i kombinacija materijala otvorila je nove horizonte za 

modernu arhitekturu, omogućavajući projektovanje i izgradnju zgrada koje nisu samo 

funkcionalne već i estetski upečatljive. 

Zatim je došla građevinska industrija, koja je iskoristila mogućnosti koje nudi 3D 

štampa, revolucionišući način na koji se zgrade grade. Danas ova tehnologija omogućava 

štampanje celih kuća sa velikom preciznošću i za veoma kratko vreme. Ovaj razvoj 

omogućava stvaranje konstrukcija koje su trajnije, isplativije i održivije u poređenju sa 

tradicionalnim metodama gradnje. 

Mogućnost štampanja celih kuća pomoću 3D štampača takođe omogućava upotrebu 

novih materijala, koji obezbeđuju bolju toplotnu i zvučnu izolaciju, a istovremeno 

smanjuju otpad tokom izgradnje. Ova metoda može značajno smanjiti troškove izgradnje, 

jer zahteva manje rada i materijala, a istovremeno ubrzava proces završetka. Dakle, 

građevinski sektor se nadograđuje, nudeći pristupačnija i održivija rešenja za izgradnju 

domova i drugih objekata. 

U Meksiku je džinovski 3D štampač, visok 33 stope (10m), korišćen za stvaranje 

čitavog naselja za porodice kojima je potrebna. Ova inovativna inicijativa, saradnja 

između organizacija kao što su New Story i ICON, imala je za cilj da reši problem 

nedostatka stanova u ruralnim oblastima. 3D štampane kuće su dizajnirane da izdrže 

seizmičku aktivnost u regionu i rizike od poplava, a izgrađene su korišćenjem naprednih 

materijala koji nude bolju izdržljivost i izolaciju od tradicionalnih domova. Izgradnja 

svake kuće trajala je otprilike 24 sata. 

Proces izgradnje 3D štampanih kuća predstavlja inovativan i revolucionaran razvoj u 

oblasti građevinarstva, jer omogućava brzo i isplativo stvaranje domova. Međutim, ova 
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tehnologija nosi i značajan rizik: potencijalni gubitak mnogih poslova. Automatizacija 

procesa izgradnje pomoću 3D štampača mogla bi smanjiti potrebu za tradicionalnim 

ručnim radom, ugrožavajući poslove vezane koje rade ljudi, kao što su radnici, 

građevinari i zanatlije. Iako inovativne tehnologije nesumnjivo nude prednosti, one takođe 

stvaraju potrebu za pažljivom ravnotežom između napretka i društvenog uticaja. 

 

 

Slika 26:  House made by 3D printer  

(Izvor: https://i.ytimg.com/vi/K3N7kA7bxeI/maxresdefault.jpg) 

 

 

4.8 Gejming industrija 
 

Minijature za društvene igre su među najdinamičnijim segmentima industrije zabave, 

sa sve većom potražnjom gejming entuzijasta, kolekcionara i kreatora. Koriste se u raznim 

igrama, od društvenih i strateških igara do kartaških igara, pa čak i digitalnih medija poput 

video igara. Ova mala umetnička dela poboljšavaju iskustvo pripovedanja i igranja igara, 

stvarajući impresivniju interakciju za korisnike. 

Tradicionalna metoda izrade minijatura uključuje vajanje, livenje i reprodukciju 

pomoću kalupa — procese koji zahtevaju značajan ručni rad i vreme. Uprkos visokom 

kvalitetu koji se može postići, ove metode su često skupe i nedovoljno fleksibilne za 

masovnu proizvodnju ili prilagođene dizajne. 3D štampa je napravila revoluciju u ovoj 

oblasti omogućavajući stvaranje minijatura sa većom brzinom, preciznošću i smanjenim 

troškovima. 

https://i.ytimg.com/vi/K3N7kA7bxeI/maxresdefault.jpg
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Koristeći 3D štampu, dizajneri igara mogu kreirati prototipove i finalne proizvode sa 

složenim detaljima koje bi bilo teško postići tradicionalnim metodama. Ova tehnologija 

takođe otvara put za proizvodnju prilagođenih minijatura, omogućavajući korisnicima da 

dizajniraju jedinstvene likove ili predmete za svoje igre. Shodno tome, 3D štampa ne 

samo da poboljšava efikasnost industrije, već i obogaćuje iskustvo igrača, čineći 

minijature sastavnim delom kreativne i zabavne produkcije. 

 

 

Slika 27:  3D štampa u gejming industriji 

(Izvor:https://gr.china3dprinting.com/Content/uploads/2022850312/20221025094929ed146c8221cd4b7a9d

92d6861c169bb9.jpg) 

 

4.9 Umetnost 
 

3D štampa je, između ostalog, sredstvo izražavanja i stvaranja, i iz tog razloga nije 

mogla da izostane iz sveta umetnosti. Kroz ovu tehnologiju, umetnici su dobili priliku da 

kreiraju radove sa preciznim detaljima i složenošću, nešto što je u prošlosti izgledalo 

nemoguće ili, ako je bilo moguće, bilo je neverovatno dugotrajno. 

Upotreba 3D štampe u umetnosti omogućila je eksperimentalno istraživanje novih 

materijala i oblika. Umetnici sada imaju mogućnost da istražuju nove načine 

kombinovanja materijala kao što su plastika, metali, pa čak i biološke supstance da bi 

stvorili umetnička dela sa jedinstvenim svojstvima. Sposobnost preciznog repliciranja i 

prilagođavanja štampanih formi uvela je novu dimenziju u proizvodnju i kolekciju 

umetnosti, omogućavajući umetnicima da ponovo kreiraju iste forme u različitim 

razmerama ili sa različitim materijalima – nešto što je bilo nemoguće sa tradicionalnim 

umetničkim tehnikama. 
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3D štampa u umetnosti je takođe otvorila nove mogućnosti u oblasti personalizovane 

umetnosti. Umetnici sada imaju mogućnost da kreiraju komade koji savršeno odgovaraju 

željama njihovih klijenata, kao što su prilagođene skulpture i poprsja koje precizno 

hvataju crte lica osobe, kao i umetnička dela koja odražavaju individualne ukuse ili 

interesovanja. Ovo je donelo novi nivo popularnosti umetnosti, jer kolekcionari i 

entuzijasti sve više traže jedinstvene komade koji odražavaju njihov lični identitet. 

Konačno, 3D štampa je doprinela evoluciji digitalnog sveta umetnosti omogućavajući 

umetnicima da svoje digitalne kreacije prenesu u fizički svet. Integracija digitalnih 

tehnologija sa tradicionalnom umetnošću dovela je do novog oblika „digitalne skulpture“, 

gde umetnici mogu da dizajniraju svoja dela koristeći softver, a zatim da ih štampaju 

pomoću 3D štampača. Ovo novo polje omogućava umetnosti da se razvija i izražava na 

načine koji su donedavno bili nezamislivi. 

 

Slika 28:  Kuća napravljena od 3D štampača  

(Izvor:https://images.cults3d.com/9sisYYV1EQPCloQySU4I1zb9lw=/246x246/filters:no_upscale()/https://fb

i.cults3d.com/uploaders/26846188/illustration-file/892e8726-4d60-4986-9554 49d6c986dca8/image.jpg) 
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Veb lokacije za proširenje znanja o tehnologijama 3D štampanja 

 

Ispod je lista veb lokacija koje ističu različite primene 3D štampanja u industriji, sa ciljem 

da se unapredi znanje čitalaca ovog priručnika i promoviše razumevanje inovativnih 

tehnologija. 

1. Bambu Lab X1 Series | Introduction    

 https://youtu.be/Eci4iFoyoS4 

2.   3D Printed Metal vs CNC Machined - How Strong? https://youtu.be/Js3bJ1B8ySM  

3. 3D Printing Food and Cooking It With Lasers 

https://youtu.be/5IpqV15frb4  

4. 3D printing in Automotive: How Škoda Auto made it 

https://youtu.be/d606FD9cItc  

5. 3D printing in the auto industry 

https://youtu.be/ylRn40wDkr8  

6. 3D Printing Is Changing the World 

https://youtu.be/GV8zPtqOyqg  

7. 10 AMAZING 3D Printing Projects: Rocky Mountain RepRap Festival 2023 

https://youtu.be/ZXg_Ml6xJGU  

8. Developing 3D Printed Drugs for Personalized Medicine with FabRx | 3D Interviews 

| 3Dnatives 

https://youtu.be/nyJReEPmcow  

9. How 3D Printed Food Can Change the Way We Look at Eating 

https://youtu.be/TeeSYhPeCLw  

10.   How 3D printing is spurring revolutionary advances in manufacturing and design. 

https://youtu.be/Adl1Sn86ojs  

11. How Good are Professional 3D Printed Metal Parts? 

https://youtu.be/o1vrfEl1uc8  

12. How medical 3D printing could solve the shortage of organ donations. 

https://youtu.be/LTwHsiCbbgs  

13. MATT Architecture: Rapid model making with 3D printing - Ultimaker: 3D Printing 

Story 

https://youtu.be/mMU_FG-KuX4  

https://youtu.be/Eci4iFoyoS4
https://youtu.be/Js3bJ1B8ySM
https://youtu.be/5IpqV15frb4
https://youtu.be/d606FD9cItc
https://youtu.be/ylRn40wDkr8
https://youtu.be/GV8zPtqOyqg
https://youtu.be/ZXg_Ml6xJGU
https://youtu.be/nyJReEPmcow
https://youtu.be/TeeSYhPeCLw
https://youtu.be/Adl1Sn86ojs
https://youtu.be/o1vrfEl1uc8
https://youtu.be/LTwHsiCbbgs
https://youtu.be/mMU_FG-KuX4
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14. Metal 3D Printing | The Future of Manufacturing? 

https://youtu.be/NkMRzpobmQQ 

15. Next Generation of 3D Printed Surgical Instruments 

https://youtu.be/2XlHMR01NYA  

16. Prusa XL at Volkswagen Academy - How 3D Printing Is Used There 

https://youtu.be/q9-ut8EgUHs  

17. The 3D printing revolution | DW Documentary 

https://youtu.be/k0poVtBhIsQ  

18. The Genius of 3D Printed Rockets 

https://youtu.be/kz165f1g8-E  

19. Can 3D Printing be Art? 

 https://www.youtube.com/shorts/fz7LXsJb_-o?feature=share  

20. 3D Printing Transforming the Gaming Industry 

https://youtu.be/axTJXnojuIY  

 

 Internet sadrži mnoštvo video snimaka koji prikazuju impresivne primene 3D 

štampanja u industriji, nudeći gledaocima jedinstvenu priliku da istraže ovu inovativnu 

tehnologiju. Kroz ove video snimke može se posmatrati kako se 3D štampa koristi za 

izradu prototipa, kreiranje prilagođenih proizvoda ili proizvodnju komponenti visoke 

preciznosti. Gledaoci stiču sposobnost da razumeju funkcionalnost tehnologije, crpe 

inspiraciju iz njenih kreativnih primena i identifikuju načine da je iskoriste u svojim 

oblastima. Ovi video snimci služe kao obrazovna sredstva, pružajući praktične ideje i 

primere koji mogu inspirisati učenike da inoviraju ili poboljšaju profesionalne aktivnosti 

koje mogu razviti u budućnosti korišćenjem 3D dizajna i štampanja. 

 

 

 

 

 

 

 

https://youtu.be/NkMRzpobmQQ
https://youtu.be/2XlHMR01NYA
https://youtu.be/q9-ut8EgUHs
https://youtu.be/k0poVtBhIsQ
https://youtu.be/kz165f1g8-E
https://www.youtube.com/shorts/fz7LXsJb_-o?feature=share
https://youtu.be/axTJXnojuIY
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Zaključak 
 

3D štampa u industriji je dokazala svoju sposobnost da revolucioniše i podstiče 

inovacije, utičući na širok spektar sektora. Mogućnost kreiranja specijalizovanih predmeta 

sa željenom preciznošću, čak i sa složenim geometrijama koje je nemoguće proizvesti 

tradicionalnim metodama, povećava produktivnost i smanjuje greške. Ovo, zauzvrat, 

povećava fleksibilnost i brzinu u proizvodnim procesima, omogućavajući brži razvoj 

novih proizvoda i tehnologija, a istovremeno doprinosi održivosti minimiziranjem otpada 

i optimizacijom upotrebe sirovina. 

Iako ova tehnologija nudi brojne prednosti, nije bez izazova. Jedna od najvećih 

prepreka je potreba za specijalizovanom obukom i prilagođavanjem radnika novim 

metodama proizvodnje. Automatizacija i upotreba 3D štampača izazivaju zabrinutost u 

vezi sa gubitkom posla, jer su određeni procesi koji su nekada zahtevali ručni rad sada 

zamenjeni mašinama. Uprkos ovim zabrinutostima, povoljne mogućnosti koje nudi 3D 

štampa čine ovu tehnologiju kamenom temeljcem za industriju budućnosti. Sve u svemu, 

3D štampa može dovesti do istinske transformacije u proizvodnim i kreatorskim 

sektorima, poboljšavajući upravljanje resursima i povećavajući efikasnost. Istovremeno, 

predstavlja nove mogućnosti za poboljšanje kvaliteta života, bilo kroz personalizovane 

proizvode ili nudeći pristupačnija i održivija rešenja. Uz pravu strategiju i prilagođavanje 

izazovima koji se mogu pojaviti, 3D štampa može da igra centralnu ulogu u izgradnji 

naprednije i zelenije budućnosti za industriju. 
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Deo 2 : FreeCAD program  
 

Uvod 
 

Drugi deo ovog priručnika prati metodologiju korak po korak i uči vas da koristite 

softver za dizajn FreeCAD za pravljenje parametarskih 3D čvrstih komponenti, kao i za 

pravljenje 2D crteža. Ovaj priručnik se ne fokusira samo na upotrebu alata i komandi 

FreeCAD-a, već i na koncept dizajna. Svako poglavlje u ovom priručniku sadrži uputstva 

koja korisnicima pružaju uputstva korak po korak za lako kreiranje dizajna i crteža. Svako 

poglavlje se završava praktičnim testom koji omogućava korisnicima da iskuse 

prilagođene i moćne mogućnosti FreeCAD-a za poboljšanje veština na kraju svakog 

poglavlja i dodatne beleške i savete. Uputstva za obavljanje bilo koje radnje su 

obezbeđena maksimalnim brojem ilustracija tako da korisnik može lako i efikasno da 

izvrši radnje o kojima se govori u knjizi. Postoji puno ilustracija koje čine proces učenja 

efikasnim. Štaviše, većina alata u ovom priručniku se razmatra u obliku uputstva korak po 

korak. Počevši od osnova, istražićete interfejs i terminologiju FreeCAD-a, postavljajući 

jaku osnovu za vašu avanturu 3D modeliranja. 

 

1. Šta je FreeCAD? 
 

FreeCAD je aplikacija za parametarsko 3D modeliranje otvorenog koda, napravljena 

prvenstveno za dizajniranje objekata iz stvarnog života. Parametrijsko modeliranje opisuje 

određeni tip modeliranja, gde se parametrima kontrolišu oblik 3D objekata koje 

dizajnirate. Na primer, oblik cigle se može kontrolisati pomoću tri parametra: visine, 

širine i dužine. U FreeCAD-u, kao i u drugim parametarskim modelarima, ovi parametri 

su deo objekta i mogu se menjati u bilo kom trenutku, nakon što je objekat kreiran. Neki 

objekti mogu imati druge objekte kao parametre, na primer, možete imati objekat koji 

uzima našu ciglu kao ulaz i kreira kolonu od nje. Parametarski objekat možete zamisliti 

kao mali program koji kreira geometriju iz parametara. FreeCAD nije dizajniran za 

određenu vrstu posla, ili za pravljenje određene vrste objekata. Umesto toga, omogućava 

širok spektar upotreba i dozvoljava korisnicima da proizvode modele svih veličina i 
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namena, od malih elektronskih komponenti do delova za 3D štampanje, pa sve do zgrada. 

Svaki od ovih zadataka ima različite namenske skupove alata i tokova posla. 

FreeCAD je takođe multiplatforman (radi na potpuno isti način na Windovs, Mac OS i 

Linux platformama) i otvorenog je koda. Budući da je otvorenog koda, FreeCAD ima 

koristi od doprinosa i napora velike zajednice programera, entuzijasta i korisnika širom 

sveta. FreeCAD je u suštini aplikacija koju su napravili ljudi koji je koriste, umesto da je 

napravi kompanija koja pokušava da vam proda proizvod. I naravno, to takođe znači da je 

FreeCAD besplatan, ne samo za korišćenje, već i za distribuciju, kopiranje, modifikovanje 

ili čak prodaju. 

 

1.1 Instalacija 
 

FreeCAD FreeCAD koristi LGPL licencu, što znači da možete slobodno da preuzimate, 

instalirate, redistribuirate i koristite FreeCAD na način na koji želite, bez obzira na vrstu 

posla koji ćete sa njim obavljati (komercijalni ili nekomercijalni). Niste obavezni ni na 

jednu klauzulu ili ograničenje, a fajlovi koje pravite uz to su u potpunosti vaši. Jedina 

stvar koju licenca zaista zabranjuje je da tvrdite da ste sami programirali FreeCAD! 

 

 

Podešavanje osnovnih parametara 

 

Kada se FreeCAD instalira, možda ćete želeti da ga otvorite i podesite nekoliko 

podešavanja. Podešavanja u FreeCAD-u se nalaze u meniju  

Edit – Preferences-General 

Jezik:  

FreeCAD će automatski izabrati jezik vašeg operativnog sistema, ali možda biste želeli da 

to promenite. 

General – Language - Change language 
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Opcije skladištenja: Kao i svaka složena aplikacija, FreeCAD se može s vremena na 

vreme srušiti. Ovde možete da konfigurišete nekoliko opcija koje će vam pomoći da 

oporavite svoj rad u slučaju pada. 

 

Document - Save AutoRecovery information every (staviti 10min) 

Jedinice: Ovde možete postaviti podrazumevane jedinice koje želite da koristite. Kasnije 

će se lakše raditi na primerima, ako ostanu u mm/kg/s/degree. 

Unit – Unit system 
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Promena boje pozadine: 

Edit – Preferences-Display-Colors-Color gradient 

 

Klikom na okvir Top color, otvara nam se novi prozor u kome možemo izabrati boju 

pozadine. 

 

Prevlačenjem pokazivača miša biramo osnovnu boju, a vertikalnim klizačem biramo 

nijansu te boje. 
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2.  2D crtež 
 

Da bi smo kreirali nov FreeCAD dokument idemo na karticu File→New. 

 

Slika 2-01 

Nakon otvaranja novog dokumenta, potrebno je izabrati način manipulacije upotrebom 

miša. 

Otvaranjem kartice CAD pojavljuju se različite mogućnosti manipulacija. 

 

Slika 2-02 

Biramo karticu Touchpad. Nakon njenog otvaranja zadržimo kursor miša na njoj da bi se 

pojavio Touchpad stil navigacije. Vidimo da postoje 10tak stila navigacije. U ovom 

tutorialu ćemo koristiti Touchpad stil navigacije zato što mogu da ga koriste i korisnici 

koji isključivo koriste Touchpad na svojim laptopovima. Ovde je slikovito predstavljeno 

uputstvo za selektovanje, zumiranje, rotiranje i pomeranje. Kako za rukoovanje tačpad-

om tako i za  rukovanje mišem. 



Step by Step in 3D printing 

 

 

49 

 

 

Slika 2-03 

Da bi smo isprobali kako to praktično funcioniše, nacrtaćemo jedan prost crtež i na njemu 

praktično isprobati sve mogućnosti. 

Postupak za aktiviranje prozora u kome ćemo nacrtati naš crtež je sledeći: klikom na 

padajući meni Start→Sketcher 

 

Slika 2-04 

 

Klikom na Sketcher karticu pojavljuje nam se veći broj ikona kao na sledećoj slici 2-05: 

 

Slika 2-05 

Klikom na meni Sketch→Create sketch 
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Slika 2-06 

Pojavljuje se sledeći prozor za izbor ravni u kojij želimo da nacrtamo naš crtež. Ovde je 

ponuđena XY ravan što prihvatamo klikom na OK. 

 

Slika 2-08 

Kao što vidimo, mnoge od ikonica za crtanje su sada postale aktivne. 

 

Slika 2-09 

Takođe, pojavljuje se koordinatni sistem sa X (crvena linija) i Y (zelena linija), i centar 

koordinatnog sistema (crvena tačka, u daljem tekstu CKS) 

 

Slika 2-08 

Prvo ćemo da nacrtamo jednu kružnicu. Klikom na naredbu za crtanje kružnica  

(levi klik mišem, udaljavamo se od centra kružnice koliko želimo pa zatim ponovo levi 

klik mišem). 

 

Slika 2-10 
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NAPOMENA: nakon crtanja kružnice, naredba za crtanje je još uvek aktivna tako da 

možemo da crtamo narednu kružnicu. Kada nam više nije potrebna, isključujemo je 

pomoću tipke ESC na tastaturi računara ili desnim klikom miša. 

U levom delu ekrana u prozoru Combo View→Solver messages →Under constrained 

postoji poruka 3 Dof(s) (degree of freedom), što znači da našoj kružnici treba da 

definišemo 3 parametara: udaljenost centra po X i Y pravcu i prečnik kružnice. 

 

Slika 2-11 

 

Stepen slobode (DOF) ukazuje na moguće kretanje jednog elementa. Na primer, tačka se 

može pomerati i u horizontalnom i u vertikalnom pravcu, tako da ima dva stepena 

slobode. Prava je definisana sa dve tačke, tako da ukupno ima četiri stepena slobode. Ako 

definišemo jednu od tih tačaka, onda ceo sistem ima na raspolaganju samo dva stepena 

slobode; ako dodatno fiksiramo horizontalno kretanje preostale tačke, ostaje nam samo 

jedan stepen slobode; a ako fiksiramo i vertikalno kretanje ove tačke, onda poslednji 

stepen slobode nestaje i linija se više ne može pomeriti sa svog položaja. 

Ograničenja su „pravila“ koja nam govore pod kojim uslovima se geometrijski objekat 

može pomerati i za koliko. Koriste se za uklanjanje stepena slobode tako da skica ima 

stabilan oblik. Ako eliminišemo sve stepene slobode, onda je skica potpuno ograničena i 

ima fiksni oblik, tj. potpuno je definisana odnosno njene tačke se uopšte ne mogu 

pomerati. Uopšteno govoreći, dobra je ideja potpuno ograničiti skice jer će to rezultirati 

stabilnim modelima. 

Postoje dve glavne vrste ograničenja: 

Geometrijska ograničenja definišu karakteristike oblika bez definisanja tačnih dimenzija, 

na primer, horizontalnost, vertikalnost, paralelnost, upravnost i tangentnost. 

Datumska ograničenja definišu karakteristike oblika navođenjem dimenzija, na primer, 

numeričke dužine ili ugla. 
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Sada ćemo da dimenzionišemo našu kružnicu da bi kompletno bila definisana u našem 

radnom prostoru. Klikom na naredbu Constrain horizontal distance , a zatim 

selektujemo centar kružnice pa zatim selektujemo CKS pojavljuje se prozor Insert Lengh 

u kome unosimo željenu vrednost po X osi (npr.40mm). 

 

Slika 2-12 

Postupak se ponavlja i za definisanje centra kružnice u Y pravcu koordinatnog sistema 

korišćenjem komande , prvo selektujemo centar kružnice, a zatim selektujemo CKS. 

Ovde možemo uneti vrednost 30mm. 

 

 

Slika 2-14 

Sada nam ostaje samo još da definišemo prečnik kružnice klikom na komandu Constrain 

arc or circle  , a zatim klikom na kružnicu nakon čega se pojavljuje prozor Insert 

diametar, gde unosimo željeni prečnik kružnice, npr. 45mm (Slika 2-15). 
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Slika 2-15 

NAPOMENA: ukoliko se desi da unesemo pogrešnu vrednost za dimenzije ili naknadno 

želimo da je izmenimo, priđemo pokazivačem miša do željene dimenzije (npr. prečnika 

kružnice) dok ne promeni boju (ne požuti) pa dvoklikom opet aktiviramo prozor Insert 

diametar u kome unesemo željene izmene. 

NAPOMENA: drugi način za promenu dimenzija je upotrebom Combo View prozora u 

kome nađemo Constrains prozor. Ovde vidimo 3 dimenzije kružnice. Dvoklikom na 

neku od njih opet se pojavljuje prozor Insert u kome unosimo željene izmene. 

 

Slika 2-16 

NAPOMENA: takođe, ukoliko se kote (dimenzije) preklapaju, možemo ih pomerati levo, 

desno, gore, dole kako bi postale pregledne. Takođe priđemo pokazivačem miša dok 

dimenzija ne promeni boju (ne požuti), kliknemo na nju i vršimo pomeraj u željenom 

pravcu. 

NAPOMENA: ako želite da privremeno onemogućite ograničenje, možete ga selektovati 

Activate/deactivate constraint. Kada želite ponovo da ga aktivirate, ponovite postupak 
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Slika 2-17 

Na ovaj način smo kompletno definisali našu kružnicu u odnosu na CKS, a u prozoru 

Combo View→Solver messages je sada Fully constrained, što znači da je kružnica, 

odnosno naša skica potpuno definisana. 

 

Slika 2-18 

Sada u prozoru Combo View, idemo na Close čime izlazimo iz aktivnog prozora za 

crtanje i vidimo naš crtež i izometriji. 

Sa desne strane u gornjem uglu ekrana (slika 2-20) vidimo kocku za navigaciju. Klikom 

na neku od strelica, vršimo rotaciju našeg crteža. Možemo kliknuti i na stranicu same 

kocke, recimo TOP stranicu da vidimo prikaz crteža u XY ravni u kojoj smo i crtali. 

Paralelno sa rotiranjem našeg crteža, rotira se i koordinatni sistem koji se vidi u donjem 

desnom uglu ekrana (slika 2-21). 

 

Slika 2-20 Slika 2-21 

Komande za drugi način manipulacije crtežom, prikazane su na slici 2-03. Kombinacijom 

tastera SHIFT, CTRL i ALT sa tasterima miša moguće su razne kombinacije selektovanja, 

rotiranja, zumiranja i pomeranja crteža u zavisnosti od naše potrebe. Ove komande je 

potrebno dobro uvežbati kako bi smo mogli da postavimo crtež odnosno kasnije 3D 

model onako kako želimo. 
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Sada ćemo da nacrtamo jedan pravougaonik dimenzija 60x40mm, koji je udaljen 20mm u 

X pravcu od CKS i 25mm u Y pravcu od CKS. Da bi smo to uradili treba da se vratimo u 

radni prostor u kome je moguće crtati. U prozoru Combo View, aktiviramo Sketch 

dvoklikom (slika 2-22),  

 

Slika 2-22 

a zatim koristimo naredbu Create rectangles, koja ima nekoliko opcija. Izabraćemo 

opciju Rectangle (slika 2-23).  

     

   

 

 

Slika 2-23 

Zatim crtamo pravougaonik. 

 

Slika 2-24 

U Combo view prozoru vidimo da se javljaju 4 nedefinisana parametra pravougaonika 4 

DoF(s) (crvena strelica, slika 2-25). 

 

Slika 2-25 
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To su sledeći parametri: širina i dužina pravougaonika, položaj pravougaonika u X I Y 

pravcu u odnosu na PKS. Sada ćemo da definišemo te parametre uz pomoć naredbi 

opisanih kod definisanja kružnice. Kada unesemo ove parametre na crtežu u prozoru 

Combo View će se pojaviti poruka Fully constrained što znači da smo sve uspešno 

definisali. 

Ove horizontalne i vertikalne crtice pored stranica pravougaonika označavaju da su te 

stranice paralelene sa X, odnosno Y osom koordinatnog sistema. 

 

Slika 2-26 

Nacrtajmo sada još jednu kružnicu, prečnika 30mm, udaljenu od CKS 30mm u +X pravcu 

i 40mm u +Y pravcu ali u novom radnom prostoru za crtanje. 

Postupak za aktiviranje prozora u kome ćemo nacrtati naš novi crtež je opisan na početku 

tutoriala (Slika 2-04): klikom na padajući meni Start→Sketcher 

 

Slika 2-27 

Zatim klikom na meni Sketch→Create sketch 

 

 

Slika 2-28 
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Pojavljuje se prozor za izbor ravni u koji želimo da nacrtamo naš novi crtež. Opet je 

ponuđena XY ravan što prihvatamo klikom na OK i crtamo našu kružnicu i sa zadatim 

parametrima. 

 

Slika 2-29 

NAPOMENA: ovde takođe tasterom ESC na tastaturi izlazimo iz neke aktivne naredbe, 

npr. za horizontalno ili vertikalno dimenzionisanje kružnice ili za definisanje prečnika 

kružnice. 

Kada smo završili crtanje naše nove kružnice, opet u prozoru Combo View idemo na 

Close, nakon čega u njemu vidimo naša dva radna prostora za crtanje , Sketch-a. 

 

Slika 2-30 

U radnom prostoru Sketch smo nacrtali prvu kružnicu i pravougaonik, a u Sketch001 smo 

nacrtali našu drugu kružnicu. 

Komandom Fit all (slika 2-31), zumiramo na radnom prostoru sve crteže, a komandom 

Fit selection zumiramo samo selektovani Sketch, koji selektujemo u prozoru Combo 

View (slika 2-33), npr. Sketch001 

 

Slika 2-31   Slika 2-32        Slika 2-33 

U rozoru Combo View desnim klikom miša pa selekcijom Rename (slika 2-34), menjamo 

ime našeg prvog Sketch-a u: Kružnica Ø45mm i pravougaonik 60x40mm.  
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Na isti način promenimo ime i drugom crtežu, Sketch001 u: Kružnica Fi30mm (slika 2-

35) 

 

Slika 2-34   Slika 2-35 

 

 

ZADATAK ZA VEŽBU 

 

 

Potrebno je nacrtati 2 pravougaonika i 2 kružnice.Pravougaonik 35x25mm i kružnicu Ø20 

nacrtati u Sketch-u, a pravougaonik 30x20 i kružnicu Ø30 u Sketch001-u, a zatim im 

promentiti imena u „Crtež01“ i „Crtež02“ 

 



Step by Step in 3D printing 

 

 

59 

 

3. 2D crtež: definisanje o grničenja, crtanje geometrijskih oblika 

 

Now Sada ćemo da nacrtamo, trougao, petougao,kružni luk (četvrtinu kružnice) koji 

tangira pravu liniju, upotrebu komandi za zaobljenje i upotrebu komande za crtanje više 

spojenih linija 

Potrebno je nacrtati jednakostranični trougao, čija je stranica dužine 20mm. Ovaj trougao 

treba da bude udaljen po 20mm u -X i Y pravcu od CKS. 

Otvaramo nov dokumenat i otvaramo Sketcher. Biramo komandu za crtanje linije Create 

line pa pa zatim crtamo proizvoljni trougao.  

 

Slika 3-01 

NAPOMENA: Izborom ove komande primećujemo da se kursor miša pretvorio u beli 

krstić. Nakon nacrtane prve linije, prilazimo krstićem na krajnju tačku prve duži i tada se 

pojavljuje i crveni krstić. Tada klik mišem i nacrtamo i drugu liniju. Na ovaj način 

obezbeđujemo da linije budu povezane. Zatim prelazimo i na crtanje 3 linije.  

 

Slika 3-02 

Sa leve strane u Combo View vidimo da u okviru prozora Constrains imamo 3 

ograničenja: Constrains1, Constrains2 i Constrains3 

 

Slika 3-03 

Klikom na neki od Constrains-a videćemo na trouglu zeleno teme trougla. To znači da su 

dve duži trougla spojene u toj tački. U sledećem slučaju je selektovan Constrains1 koji 
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pokazuje levo teme trougla. U prozoru Combo View→ Constrains ćemo videti sva 

ograničenja koja ćemo dodeliti našem crtežu.  

 

Slika 3-04 

Na sledećoj slici se vide moguća ograničenja. 

 

Slika 3-05 

Objasnićemo neke od njih. 

  
 

Slika 3-06 Slika 3-07 Slika 3-08 

  
 

Slika 3-09 Slika 3-10 Slika 3-11 

 
 

 

Slika 3-12 Slika 3-13 Slika 3-14 

 

Constrain coincident -ograničenje koincidentnosti- poklapanja (Slika 3-06) – ovo 

ograničenje omogućava da se 2 tačke poklapaju.Selektujemo komandu, kliknemo na 
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desno teme trougla, zatim na CKS. Nakon toga će teme preći u CKS (slika 3-15). Nakon 

isprobane komande idemo na Edit→Undo kako bi smo se vratili korak nazad. 

 

Slika 3-15 

Nacrtaćemo dve proizvoljne linije. 

 

Slika 3-16 

Zatim aktiviramo komandu Constrain coincident, kliknemo na desni kraj prve duži, 

zatim na kraj druge. Videćemo da su se duži spojile u jednoj tački. 

 

Slika 3-17 

NAPOMENA: Ona tačka koju smo prvo selektovali, ostaje fiksna, a druga tačka se lepi 

na prvu. 

Constrain verticaly – postavljanje ograničenja vertikalnosti neke linije (slika 3-7). 

Selektujemo komandu, zatim kliknemo na desnu stranicu trougla. Primećujemo da je 

postala vertikalna i da pored nje postoji mala crvena linija koja označava vertikalnost. To 

možemo da vidimo i u Combo View→ Constrains (Slika 3-17). Klikom na Constraint4 

mala crvena linija koja označava vertikalnost će postati zelena . Nakon isprobane 

komande idemo na Edit→Undo kako bi smo se vratili korak nazad. 

 

Slika 3-16  Slika 3-17 
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Constrain horizontally - postavljanje ograničenja horizontalnosti neke linije (slika 3-8). 

Constrain parallel – postavljanje ograničenja paralelnosti (slika 3-9). Ovo ograničenje 

koristimo kada želimo da dve linije budu paralelne.  

 

Slika 3-17a 

Nacrtaćemo dve proizvoljne linije. Zatim klik na komandu Constrain parallel  , pa 

na te te dve linije. Linije će postati paralelne. 

 

Slika 3-17b 

Constrain parpandicular – postavljanje ograničenja upravnosti (slika 3-10) kada želimo 

da 2 linije budu pod uglom od 90 stepeni. Na sledećoj slici vidimo da su donja i desna 

stranica trougla pod pravim uglom (slika 2-18). 

 

Slika 2-18 

 

Constrain tangent – postavljanje ograničenja tangentnosti (3-11) kada želimo da se 

recimo jedna duž i kružni luk tangiraju (slika 3-19). 

 

Slika 3-19 
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Constrain equal – postavljanje ograničenja jednakosti (slika 3-12) kada želimo da dve ili 

više linija, kružnica ili bilo koji geometrijski oblici budu jednaki. 

Nacrtaćemo 3 proizvoljne kružnice kao na slici. 

 

Slika 3-19b 

Zatim klik na komandu Constrain equal , zatim na prvu pa na drugu kružnicu. 

Videćemo da će kružnice postati iste. 

NAPOMENA: Koji kružnicu prvo selektujemo, takvih dimenzija će biti i sledeća. 

 

Constrain symmetrical – postavljanje ograničenja simetričnosti (slika 3-13) kada želimo 

da recimo 2 tačke duži (odnosno duž) budu na simetričnom rastojanju u odnosu na zadatu 

duž. Na slici 3-20 se vidi da je upotrebom ove komande vertikalna duž postala simetrala 

horizontalnoj duži. Poslupak je sledeći: selektujemo prvo jednu tačku horizontalne duži, 

zatim drugu i na kraju vertikalnu duž pa zatim komandu Constrain symmetrical 

 

Slika 3-20 

Constrain block – postavljanje ograničenja fiksiranja jedne ili više linija (slika 3-14). 

Nakon upotrebe ovog ograničenja nije moguće pomerati selektovane linije ili 

geometrijske oblike. 

NAPOMENA: Sva ograničenja koja smo postavili se vide u Combo View→ Constrains. 

Ukoliko nam neko ograničenje nije više potrebno, selektujemo ga desnim klikom miša pa 

zatim Delete u pojavljenom meniju. (slika 3-21). 
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Slika 3-21 

 

Sada možemo nacrtati naš jednakostranični trougao, čija je stranica dužine 20mm. Ovaj 

trougao treba da bude udaljen po 20mm u -X i Y pravcu od CKS. Za donju stranicu 

trougla postaviti ograničenje da je horizontalna, a sve tri stranice treba da budu jednake 

(po 20mm). Trougao bi trebalo bi da izgleda ovako kao na sledećoj slici. 

 

Slika 3-22 

Na ovaj način smo naučili upotrebu nekih ograničenja. Naš trougao smo mogli i vrlo lakše 

nacrtati upotrebom komande Sketch→Sketch geometries→ Create equilateral triangle 

Sada ćemo da nacrtamo u XY delu jedan petougao, čija je donja stranica horizontalna, a 

stranice su mu po 15mm. Udaljen od CKS po 20mm u pravcu X i Y ose. Da bi smo 

izabrali naredbu za crtanje petougla idemo Sketch→Sketch geometries→Create 

pentagon. (slika 3-23). Kao što vidimo, ovde su komande za crtanje svih geometrijskih 

oblika koji su nam potrebani: tačka, linija, kružnica, kružni luk, pravougaonik, elipsa, 

hiperbola, pravougaonik, kvadrat itd. 
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Slika 3-23 

Crtež bi trebalo da izgleda kao na slici 3-24. 

 

Slika 3-24 

 

Naredni naš crtež je kružni luk (četvrtina kružnice) koji tangira pravu liniju u –X-Y delu 

koordinatnog sistema. Crtež bi trebalo da izgleda kao na sledećoj slici. 

 

Slika 3-25 

Postupak je sledeći: nacrtamo duž 20mm čiji je početak udaljen u –X pravcu 40mm, u –Y 

pravcu 20mm. Zatim Sketch→Sketch geometries→Create arc by center. 

Kliknemo ispod desnog kraja duzi i krstićem priđemo desnom kraju duži. Kada se pojavi i 

crveni krstić, kliknemo kako bi naš kružni luk bio vezan za duž. Zatim nacrtamo otprilike 
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četvrtinu kružnice. Da bi smo bili sigurni da je to prava četvrtina, moramo uvesti 

ograničenja. Klikom na centar kruga i desnu tačku kružnice pa zatim  na horizontalno 

ograničenje. Levi klik mišem ili ESC na tastaturi da bi smo napustili komandu. 

Klikom na centar kruga i gornju tačku kružnice pa zatim na vertikalno ograničenje. 

Sada smo sigurni da je u pianju četvrtina kružnice. A da bismo bili sigurni i da tangira 

duž, uvešćemo i ograničenje tangiranja Constrain tangent. Kliknemo na duž pa na kružni 

luk pa zatim na ovo graničenje. Zatim OK na iskačući prozor obaveštenja i čime i 

završavamo naš crtež. 

 

Upotreba komandi za zaobljenje 

Crtamo pravougaonik 60x40mm koji je udaljen 20mm u pravcu X ose i 30mm u pravcu –

Y ose. 

 

Slika 3-26 

Ovde imamo dve komande za zaobljenje: Sketch fillet i Constraint-preserving sketch 

fillet 

 

Slika 3-27 

Izvršićemo zaobljenje levog gornjeg ugla pravougaonika prvo jednom pa drugom 

komandom da vidimo razliku. Aktiviramo prvo Sketch fillet pa selektujemo levu i gornju 

stranicu našeg pravougaonika. Dobićemo zaobljenje kao na sledećoj slici. 
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Slika 3-28 

Sada idemo korak unazad Edit→Undo, pa selektujemo drugu komandu Constraint -

preserving sketch fillet i ponovimo postupak. Dobićemo zaobljenje kao na slici 3-29. 

 

 

 

Slika 3-29 

Primećujemo da smo upotrebom druge komande sačuvali sve dimenzije našeg crteža kao 

što i samo ime komande govori. 

Sada ćemo dimenzionisati naše zaobljenje upotrebom komande Constrain arc or circle 

 i unećemo vrednost 10mm. Zatim unosimo još jedno zaobljenje sa desne strane 

i dimenzionišemo ga istom komandom i dodeljujemo vrednost od 8mm kao na slici. 

 

Slika 3-29a 
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Sa leve strane u prozoru Combo View vidimo da je naš crtež potpuno definisan 

dimenzionisanjem oba zaobljenja (Fully constrained). 

 

 

Slika 3-29b 

 

1. Korišćenje komande za crtanje više spojenih linija – Create polyline 

Ova komanda je vrlo korisna za crtanje crteža, naročito upotrebom magičnog slova M na 

tastaturi našeg računara. Aktiviramo je sa Create polyline. 

   

Aktiviranjem komande Pritisak na taster M, prvi put Pritisak na taster M, drugi 

put 

 
  

Pritisak na taster M,treći 

put 

Pritisak na taster M, četvrti 

put 

Pritisak na taster M, peti put 

Slika 3-30 

- Aktiviranjem komande nakon nacrtane linije, sledeću liniju crtamo proizvolljno 

pod bilo kojim uglom 
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- Pritiskom na taster M prvi put, crtamo paralelnu liniju u prvj stim što ih spaja 

poprečna linija 

- Pritiskom na taster M drugi put, crtamo pravu liniju tangencijalnu prvoj i upravnu 

na nju 

- Pritiskom na taster M treći put, crtamo tangencijalni kružni luk koji se nadovezuje 

na prvu 

- Pritiskom na taster M četvrti put, crtamo kružni luk normalan na prethodnu liniju 

sa leve strane 

- Pritiskom na taster M peti put, crtamo kružni luk normalan na prethodnu liniju sa 

desne strane 

 

Korišćenje komande za isecanje linija - Trim edge 

Potrebno je nacrtati crtež približno kao na sledećoj slici sa ograničenjima da linije budu 

horizontalne i vertikalne. 

 

Slika 3-31 

 

Nakon toga aktiviramo komandu Trim edge  i priđemo do linija koje su praktično 

višak u odnosu na pravougaonik na slici. Zatim kliknemo na svaku od njih da bi smo 

oblisali taj višak. Nakon toga, trebalo bi da na crtežu ostane samo pravougaonik. 

 

Slika 3-32 
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Korišćenje komande za produžetak linija - Extend edge 

Potrebno je nacrtati 2 linije približnno kao na sledećoj slici sa ograničenjima tako da linije 

budu horizontalne. 

 

Slika 3-33 

Nakon toga aktiviramo komandu Extend edge  i priđemo do prve linije, kliknemo 

negde na njoj, a zatim pomerimo opokazivač miša na desno da bi smo je produžili, pa 

zatim kliknemo još jednom da bi smo završili sa produžetkom. Isto uradimo i sa drugom 

linijom, samo što nju produžimo ka –X osi. Trebalo bi da linije izgledaju ovako nakon 

završetka. 

 

Slika 3-34 

 

8. Korišćenje komande za deljenje linija - Split edge 

Potrebno je nacrtati jednu liniju približnio kao na sledećoj slici sa ograničenjem da linija 

bude horizontalna. 

 

Slika 3-35 

 

Nakon toga aktiviramo komandu Split edge  , zatim priđemo do linije, kliknemo 

negde na njoj, a zatim pomerimo opokazivač miša na desno, pa zatim opet kliknemo na 
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liniju, pa to ponovimo još jednom. Trebalo bi da prvobitna linija bude podeljena na 4 

linije kao na slici. 

 

Slika 3-36 

 

Kao što vidimo ograničenje horizontalnosti je ostalo. Ukoliko ova ograničenja izbrišemo i 

dodamo nova, npr. ograničenja vertikalnosti na dve linije, moguće je od prvobitne linije 

napraviti pravougaonik. 

 

Slika 3-37 
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Zadatak za vežbu 

Potrebno je nacrtati crtež kao na sledećoj slici. Woditi računa da se tačka W na crtežu 

poklapa sa CKS. 

 

Slika 3-38 

 

Zadatak za vežbu 

Potrebno je nacrtati crtež kao na sledećoj slici. Voditi računa da se tačka W na crtežu 

poklapa sa CKS. 

 

Slika 3-39 
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Zadatak za vežbu 

Potrebno je nacrtati crtež kao na sledećoj slici. 

 

Slika 3-40 

 

Zadatak za vežbu 

Potrebno je nacrtati crtež kao na sledećoj slici. 

 

 

Slika 3-41 
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4. 3D model: Prizmatični delovi 
 

From Sa padajućeg menia biramo Part Design 

 

Slika 4-01 

 

Zatim snimamo naš budući fajl. 

 

Slika 4-02 

Dajemo ime našem budućem modelu. npr. Prizmatični deo. 

 

Slika 4-03 

 

Kliknemo na ikonu Create body. 

 

Slika 4-04 
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U Combo view prozoru se pojavljuje Body, koji vidimo da je aktivan. 

 

Slika 4-05 

  

Kliknemo na Create sketch. 

 

Slika 4-06 

Biramo željenu ravan ili u Combo view prozoru ili na radnoj površini selektovanjem 

željene ravni (taster Shift+LKM pomeranjem miša vršimo rotaciju ravni). 

Biramo XY ravan u kojoj ćemo nacrtati našu crtež. Nacrtaćemo pravougaonik dimenzija 

100x60mm čiji se centar poklapa sa CKS. 

Selektujemo naredbu Centered rectangle pa zatim crtamo naš pravougaonik. 

 

 

Slika 4-07 

Crtanje krećemo iz centra koordinativnog sistema da bi se centar pravougaonika poklapao 

sa CKS. Nakon crtanja, našem crtežu dodamo željene dimenzije. 

 

Slika 4-08 

Vidimo da je crtež zelene boje nakon dimenzionisanja što znači da je potpuno definisan. 
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Idemo na Close u Combo View prozoru, zatim desni DKM na Sketch→Rename da bi 

promenili ime našeg crteža u “Pravougaonik”. 

 

Slika 4-09 

Da bi smo od našeg crteža dobili 3D prizmatični model, koristimo komandu Pad 

 

Slika 4-10 

Vidimo da se u prozoru Combo View pojavljuje prozor Pad parameters u kome 

možemo da menjamo različite parametre našeg 3D modela. 

 

Slika 4-11 

U Length unesemo 30mm i LKM van Combo View prozora da bi smo videli promenu. 

Ukoliko pritisnemo Enter na tastaturi izlazimo iz prozora Pad parameters. Ako želimo 

da unesemo neke izmene na našem 3D modelu, u prozoru Combo View DKM na 

Pad→Edit pad. 

Sada opet možemo menjati parametre po zelji našeg modela.  
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Slika 4-12 

Kliknemo na Enter ili OK u Combo View prozoru kada završimo izmene. Da bi smo 

videli gde se naš 3D model nalazi u koordinativnom sistemu, moramo ga učiniti vidljivim. 

To radimo na sledeći način: selektujemo Origin pa zatim pritisnemo dugme Space na 

tastaturi. 

 

Slika 4-13 

Vidimo da su sve 3 ravni (XY, XZ, YZ) postale vidljive.  

Da bi smo shvatili mogućnosti promene parametara opet aktiviramo prozor Pad 

parameters (DKM na Pad→Edit pad). Nakon eksperimentisanja, vraćamo se na naš 

model. 

Ukoliko želimo da nešto promenimo na našem modelu po pitanju dimenzija osnovnog 

crteža, to radimo na sledeći način: 

Klikom na strelicu levo od Pad, pojavljuje se naš osnovni crtež ”Pravougaonik” 

                 

                                  Slika 4-14    Slika 4-15 

 

DKM na Pravougaonik pa zatim Edit sketch 
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Slika 4-15 

Sada možemo da menjamo naš osnovni crtež na osnovu koga dobijamo 3D model. 

Promenićemo širinu pravougaonika na 120mm (priđemo kursorom do dimenzije, kada 

požuti dvoklik LTM, promenimo dimenziju pa OK).  

Pritiskom na Close u prozoru Combo View zatvaramo naš Sketch „Pravougaonik“ i 

vidimo da se i naš 3D model promenio. Sada je 120x60x30mm. 

 

Slika 4-17 

Sada ćemo da napravimo 2 kružna džepa na 3D modelu. Proverimo da smo u Part Design 

modu, a zatim selektujemo gornju površinu 3D modela 

 

Slika 4-18 

Pa zatim izaberemo Create Sketch 

 

Slika 4-19 

 

Sada crtamo 2 kružnice na selektovanoj površini kao na sledećoj slici, udaljene po 30mm 

i 15mm od CKS, prečnika 12mm 
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Slika 4-20 

Idemo na Close u Combo View prozoru, pa zatim selektujemo komandu Pocket. 

 

Slika 4-21 

Pojavljuje se novi prozor Pocket parameters u kojem imamo razne mogućnosti za 

menjanje parametara naša 2 kružna džepa. 

 

Slika 4-22 

U Lengh unesemo 5mm i pritisnemo OK u Combo View prozoru. Na ovaj način smo 

kreirali 2 kružna džepa na našem modelu. 

 

Slika 4-23 
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Sada ćemo izvršimo zaobljenje 4 vertikalne ivice našeg modela upotrebom komande 

Fillet. 

Selektujemo prvo četri vertikalne ivice našeg modela. Pritisnemo taster Ctrl na tastaturi i 

LKM selektujemo jednu po jednu ivicu uz rotiranje modela. Kada smo selektovali sve 4 

ivice, kliknemo na komandu Fillet 

 

Slika 4-24 

Pojavljuje se novi prozor Fillet parameters. 

 

Slika 4-25 

U Radius unesemo 10mm, zatim OK. Na ovaj način smo izvršili zaobljenje selektovanih 

ivica. 

 

Slika 4-26 

Ukoliko želimo da izvršimo neku promenu na modelu, recimo da gornje 2 ivice ne budu 

zaobljene u Combo View prozoru dvoklikom na Fillet opet aktiviramo Fillet parameters 

prozor. 
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Slika 4-27 

 U ovom prozoru selektujemo redom ivice: Edge2, Edge1, Edge8 i Edge5 da bi smo 

utvrdili koje su gornje ivice (selektovana ivica pozeleni na modelu). Kada utvrdimo koje 

su 2 ivice gornje, obrišemo ih pritiskom tastera Delete na tastaturi.  

 

Slika 4-28 

Brisanjem te 2 ivice sada bi naš model trebalo da izgleda kao na sledećoj slici: 

 

Slika 4-29 

Sada ćemo izvršimo zakošenje 2 gornje vertikalne ivice našeg modela upotrebom 

komande Chamfer. 

Prvo izvršimo selekciju gornjih ivica, zatim aktiviramo komandu Chamfer. 

 

Slika 4-30 
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Pojavljuje se novi prozor Chamfer parameters. 

 

Slika 4-31 

U Size unesemo vrednost npr. 10mm i kliknemo na OK. Sada bi naš model trebalo da 

izgleda kao na sledećoj slici: 

 

Slika 4-32 

Sada dvoklikom na Chamfer u Combo View prozoru ponovo aktiviramo Chamfer 

parameter. 

U prozoru Chamfer parametar→Type primećujemo različite mogućnosti obaranja ivica. 

 

Slika 4-33 

Ovde bi trebalo malo eksperimentisati sa ovim mogućnostima. 

Zadaci za vežbu 
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5. 3D model: osnosimetrični delovi 
 

Sa padajućeg menia biramo Part Design 

 

Slika 5-01 

 

Zatim snimamo naš budući fajl. 

 

Slika 5-02 

Dajemo ime našem budućem modelu. npr. osnosimetrični deo. 

 

Kliknemo na ikonu Create part. 

 

Slika 5-03 

 

U Combo view prozoru se pojavljuje Part, koji vidimo da je aktivan 

 

Slika 5-04 

Selektujemo Part, zatim aktiviramo naredbu Create Body. 
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Slika 5-05 

Nakon toga aktiviramo naredbu Create Sketch. 

 

Slika 5-06 

 

Biramo željenu ravan ili u Combo view prozoru ili na radnoj površini 

selektovanjem željene ravni (taster Shift+LKM pomeranjem miša vršimo rotaciju 3 

ravni). 

Ovde ne biramo XY ravan kao kod crtanja prizmatičnih delova već XZ ravan u 

kojoj se crtaju osnosimetrični delovi. 

Nacrtaćemo sad jedan crtež kao na sledećoj slici. CKS je u donjem levom uglu. 

 

Slika 5-07 

Zatim idemo na Close. 

Selektujemo komandu Revolution 

 

Slika 5-08 

Nakon čega se pojavljuje naš osnosimetrični 3D model kao na sledećoj slici: 
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Slika 5-09 

NAPOMENA: Vrlo je bitno da se kod crtanja osnosimetričnih delova izabere XZ 

ravan ca crtanje skice, kako bi se osa simetrije poklapala sa Z osom, kako zbog 

štampanja na 3D štampaču tako i zbog izrade ovakvih delova na CNC 

strugovima.  

Vidimo da se Combo View prozoru otvorio prozor Revolution parameters. 

  

Slika 5-10 

Ovde možemo menjati recimo ugao rotacije oko Z ose, npr. 270º i dobićemo 

sledeći model: 

 

Slika 5-11 

Ili promeniti osu rotacije naše skice npr. Base X Axis (rotiranje naše skice oko X 

ose) 
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Slika 5-12 

Tako da dobijamo model kao na sledećoj skici: 

 

Slika 5-13 

Mogućnosti su različite, ali vratimo se na naš potrebni 3D model gde je osa 

rotacije Z osa. 

 

5-14 

 

Selektujemo Part u prozoru Combo View, 

 

 

Slika 5-15 

zatim selektujemo površinu na kojoj želimo da crtamo, a to je gornja površina, 
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5-16 

 

a zatim standardo na Create sketch, 

 

Slika 5-17 

 

 

zatim u prozoru Combo View idemo na Model 

 

Slika 5-18 

Pa dupli klik na Sketch001 

 

Slika 5-19 

Sada nam se otvara mogućnost da crtamo na selektovanoj površini 



Step by Step in 3D printing 

 

 

90 

 

 

Slika 5-20 

Crtamo kružnicu kao na sledećoj slici: 

 

 

Slika 5-21 

Zatim Close u Combo View prozoru. 

Preimenovaćemo Sketch001 u Pattern 

 

Slika 5-22 

 

Proverimo da je aktivan Part Design 

 

 

Slika 5-23 

pa selektujemo komandu Pocket 
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Slika 5-24 

Otvara nam se novi prozor u Combo View prozoru, Pocket parameters. 

 

Slika 5-25 

Ovde podešavamo dubinu džepa npr. 5mm (Length) i ugao pod kojim je naš džep 

izdubljen npr. -20º (Taper Angle). Zatim na OK. 

Naš džep bi trebalo da izgleda kao na sledećoj slici: 

 

Slika 5-26 

Vidimo da je dno džepa izdubljeno pod uglom od 20º. 

Da bi smo ovaj džep iskopirali po kružnici, prvo selektujemo bočnu stranu džepa 

tako da pozeleni 

 

Slika 5-27 

Zatim kliknemo na komandu Polar Pattern 
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Slika 5-28 

I tada se otvara novi prozor u Combo View prozoru, Polar Pattern parameters 

 

Slika 5-29 

U ovom prozoru sada možemo da menjamo ugao (Angle). Ako je npr. 360º, džep 

će se kopirati oko cele kružnice. Takođe, ovde određujemo i ukupan broj džepova 

(Occurrences). Stavimo da je recimo 5 pa OK. Vidimo da imamo 5 džepova 

ravnomerno raspoređenih. 

 

Slika 5-30 

Na sličan način se koristi komanda Linear Pattern. Prvo u Combo View prozoru 

obrišemo Polar Pattern (DKM→Delete). Pritisnimo dugme 2 na tastaturi da bi 

smo imali TOP pogled. Sada selektujemo džep pa aktiviramo naredbu 

 

Slika 5-31 

Nakon čega se pojavljuje novi prozor u Combo View prozoru Linear Pattern 

parameter 



Step by Step in 3D printing 

 

 

93 

 

 

Slika 5-32 

U polju Lengh se definiše rastojanje na kom će se džepovi umnožavati (unesemo 

npr.30mm),a u polju Occurrences koliki će ukupan broj džepova biti (unesemo 

npr.5). U Direction postoji padajući meni u kome biramo u kom pravcu će se 

umnožavati džepovi. 

 

Slika 5-33 

Ovde izaberemo Vertical sketch axis, i čekiramo Reverse direction da bi kopije 

džepa išle naviše pa idemo na OK u Combo View prozoru. Sada bi linearno 

umnoženi džepovi trebali da izgledaju kao na sledećoj slici slici: 

 

Slika 5-34 

Na vrlo sličan način se koristi i naredba Mirrored 

 

Slika 5-35 

Aktiviranjem naredbe, otvara se novi prozor Mirrored parameters  
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Slika 5-36 

U prozoru u okviru padajućeg menija Plane, biramo oko koje ravni ili ose će biti 

kopiran džep. 
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Zadaci za vežbu 

  

Slika 5-37 

 

 

  

Slika 5-38 
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Slika 5-39 
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6. 3D model: Izrada tipskih oblika slivanjem preseka (Loft) 
 

Kreiramo novi dokumenat i snimamo ga dajući mu ime po želji. 

Idemo na Part Design 

 

Slika 6-01 

 

zatim na Create part 

 

Slika 6-01 

 

zatim na Create body 

 

Slika 6-02 

 

Zatimna Create Cketch 

 

Slika 6-03 

Selektujemo XY ravan, pa OK. 
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Sada crtamo, recimo pravougaonik dimenzija 100x60mm čiji se centar poklapa sa 

CKS. 

 

Slika 6-04 

Zatim idemo na Close. 

U Combo View prozoru promenimo ime našeg Sketch-a u 

Crtež1(DKM→Rename→ Crtež1), 

 

Slika 6-05 

 

Sada ćemo da kreiramo drugi crtež→Create Sketch 

 

Slika 6-06 

 

Biramo XY ravan, zatim OK u Combo View prozoru. 

Vidimo da na se na radnoj površini ne vidi naš prethodni crtež – pravougaonik. U 

prozoru Combo View idemo na Model 

 

Slika 6-07 
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Ovde primećujemo da je Part neaktivan. Selektujemo ga, zatim na tastaturi 

računara pritisnemo SPACE da bi postao aktivan. Sada se pojavljuje naš nacrtani 

pravougaonik. 

 

Menjamo ime Sketch001 u Crtež2, selektujemo ga, a zatim se u Combo Viev 

prozoru vraćamo u Tasks prozor. 

Sada crtamo kvadrat 30x30mm. 

 

Slika 6-08 

A zatim Close. 

Sada ovaj kvadrat treba da pomerimo u Z pravcu na željeno rastojanje npr.60mm. 

Selektujemo Crtež2 pa u prozoru ispod u okviru Attachment Offset klik na 

strelicu > ispred Position 

 

Slika 6-09 

 

Otvara nam se nova mogućnost za promenu Z rastojanja. 
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Slika 6-10 

 

Sada kliknemo na 0.00mm pored Z pravca i unesemo vrednost npr 60mm. 

Vidimo da se naš kvadrat pomerio za 60mm u pravcu +Z ose. 

  

 

Slika 6-11 

Sada selektujemo Crtež1, zatim aktiviramo naredbu 

 

Zatim u prozoru Loft parameters na Add Section pa selektujemo kvadrat u 

radnom prostoru.  

 

Slika 6-12 

Sada smo dobili naš 3D model dobijen slivanjem preseka pravougaonika i 

kvadrata. 

 

Slika 6-13 
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Primeri za vežbu 

 

 

Slika 6-14 

 

 

Slika 6-15 
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7. 3D model: izrada tipskih oblika izvlačenjem duž krive 

(Additive pipe) 
 

Kreiramo novi dokumenat i snimamo ga dajući mu ime po želji (Additive pipe) 

Idemo na Part Design 

 

Slika 7-01 

 

zatim na Create part 

 

Slika 7-02 

zatim na Create body 

 

Slika 7-03 

Zatimna Create Cketch 

 

Slika 7-04 

Selektujemo XY ravan, pa OK. 

Sada crtamo, recimo pravougaonik dimenzija 40x30mm čiji se centar poklapa sa CKS. 
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Slika 7-05 

Zatim idemo na Close. 

U Combo View prozoru promenimo ime našeg Sketch-a u 

Pravougaonik(DKM→Rename→ Pravougaonik), 

 

Slika 7-06 

Sada ćemo da kreiramo drugi crtež: selektujemo Body→Create Sketch 

 

Slika 7-07 

Biramo YZ ravan, zatim OK u Combo View prozoru. 

Biramo B-spline by control points 

 

Slika 7-08 

A zatim crtamo izlomljenu liniju otprilike kao na slici pa Esc na tastaturi ili DKM. 

Donja bela linija je zapravo naš pravougaonik ali u XY ravni (sada smo u YZ ravni). 
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Slika 7-09 

Zatim deminzionišemo ove tri tačke kao na sledećoj slici. 

 

Slika 7-10 

Pa Close u Combo View prozoru. 

Sada vidimo i pravougaonik u XY ravni i krivu liniju u YZ ravni. Preimenujemo 

Sketch001 u Kriva linija. 

Selektujemo crtež Pravougaonik u Combo View prozoru pa aktiviramo komandu Additiv 

pipe 

 

Slika 7-11 

Primećujemo da se otvorio novi prozor 
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Slika 7-12 

Da bi smo selektovani pravougaonik pomerili duž naše krive linije kliknemo na Add 

Edge pa zatim selektujemo krivu liniju u radnom prostoru, zatim na OK u Combo View 

prozoru I dobijamo naš 3D model kao na sledećoj slici. 

 

Slika 7-13 

Ukoliko želimo da jedan oblik duž linije pretvorimo u drugi, trebaće nam još jedan crtež. 

Selektujemo Additivepipe pa aktiviramo još jedan Sketch 

 

Slika 7-14 

Izaberemo i sada XY ravan pa OK u Combo View programu. Sada crtamo kružnicu 

prečnika 30mm. 

 

 

Slika 7-15 
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Zatim Close u Combo View prozoru. Crtež Sketch002 preimenujemo u Kružnica. Ovu 

kružnicu pomeramo po Z pravcu za 100mm, koliko je dužina naše krive linije. 

 

Selektujemo kružnicu pa u prozoru ispod u okviru Attachment Offset klik na strelicu ”>” 

ispred Position 

 

Slika 7-16 

Otvara nam se nova mogućnost za promenu Z rastojanja. 

 

Slika 7-17 

Sada kliknemo na 0.00mm pored Z pravca i unesemo vrednost 100mm. 

Vidimo da se naša pravougaonik pomerio za 100mm u pravcu +Z ose. Da bi smo našu 

kružnicu pomerili da se njen centar poklapa sa krajnjom tačkom krive linije pomeranjem 

za -5mm u Y pravcu (gledamo dimenzije krajnje tačke krive linije u odnosu na CKS). 

 

Slika 7-18 
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Da bi smo dobli naš 3D model, selektujemo Additivepipe u Combo View prozoro duplim 

klikom. 

Sada selektujemo Pravougaonik, zatim aktiviramo Additive Pipe naredbu. 

 

Slika 7-19 

Pa u Combo View prozoru u Section transformation, Transform mode promenimo u 

Multisection. Zatim klik na Add Section, pa selektujemo Kružnica. 

 

Slika 7-20 

Zatim OK u Combo View prozoru. 

Na ovaj način smo dobili naš 3D model koji se pretvara iz pravougaonika u kružnicu 

vođen krivom linijom. 

 

Slika 7-21 
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Primeri za vežbu 

Slika 7-21 

 

 

 

Slika 7-22 
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Deo 3: Šta je Cura program? 

 

  Uvod 
 

Ovaj priručnik sadrži detaljna uputstva (uključujući slike) za instalaciju softvera i njegovu 

konfiguraciju prema specifičnom 3D štampaču i zahtevima za štampanje korisnika. Pored 

toga, objašnjava različite funkcije i mogućnosti softvera, uključujući uvoz 3D modela, 

podešavanje postavki štampe i optimizaciju procesa štampe za različite materijale i 

željene rezultate. Ovaj priručnik je osmišljen za potrebe projekta “Step by Step in 3D 

printing”. 

1. Šta je Cura? 
 

Cura je aplikacija za rezanje fajlova za 3D štampače. Ultimaker Cura funkcioniše tako što 

deli model korisnika na slojeve i generiše g-code specifičan za štampač. Korisnici mogu 

pripremiti i iseći 3D modele za štampanje, kao i prilagoditi i optimizovati postavke 

štampe za razne 3D štampače i materijale. Kada je proces završen, g-code se može poslati 

štampaču za izradu fizičkog objekta. Cura je moćan i korisniku prijateljski softver za 3D 

štampanje sa brojnim korisnim funkcijama i mogućnostima. 

Cura je dostupna pod LGPLv3 licencom. Prvobitno je objavljena pod otvorenom 

licencom Affero General Public License verzija 3, ali je 28. septembra 2017. godine 

licenca promenjena na LGPLv3. Ovo je preferirani softver za 3D štampanje za Ultimaker 

3D štampače, ali se može koristiti i sa drugim štampačima. 

Ovaj otvoreni softver, koji je kompatibilan sa većinom desktop 3D štampača, može raditi 

sa datotekama u najčešćim 3D formatima kao što su STL, OBJ, X3D, 3MF, kao i sa 

formatima slika kao što su BMP, GIF, JPG i PNG. 

Ultimaker Cura je podržana od strane operativnih sistema koji se aktivno održavaju od 

strane njihovog proizvođača softvera ili zajednice. To trenutno znači da 'Windows 7' i 

'MacOS 10.14' više nisu podržani. 

Kompatibilni operativni sistemi: 

Windows 10 ili noviji, 64-bit 

Mac OSX 11 Big Sur ili noviji, 64-bit 

Linux, 64-bit  
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2. Instalacija  

Cura je besplatan softver i možete ga preuzeti direktno sa Ultimaker veb sajta na 

sledećem linku: https://ultimaker.com/software/ultimaker-cura/. Kao što je pomenuto 

u opisu softvera, funkcioniše na više operativnih sistema, pa treba da odaberete 

instalaciju koja odgovara vašem operativnom sistemu.

 

Nakon preuzimanja instalacije, pratite sledeće korake. 

Korak 1 

 

Nakon pokretanja instalacije, 

pojaviće se prozor dobrodošlice, 

i preporučuje se da prvo 

zatvorite ostale aplikacije pre 

nego što započnete instalaciju. 

Nakon što zatvorite ostale 

aplikacije, kliknite na „Next“. 

Korak 2 

https://ultimaker.com/software/ultimaker-cura/
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Ako se slažete sa uslovima 

korišćenja softvera, kliknite na 

„I Agree“. 

Korak 3 

 

Odaberite lokaciju i fasciklu u kojoj 

želite da instalirate softver, zatim 

pritisnite. "Next" 

      Korak 4 

 

Odaberite fasciklu za Start meni i 

kliknite. “Install” 

Korak 5 
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Na kraju, dobićete informaciju koja 

potvrđuje da je instalacija završena. 

Takođe, imaćete opciju da odmah 

pokrenete softver, u zavisnosti od 

toga da li je odabrano „Pokreni 

Ultimaker 5.6.0“. Pritisnite "Finish" 

 

 

 

 

3.  Podešavanje jezika 

Cura će automatski odabrati jezik vašeg operativnog sistema, ali ga možete 

promeniti. 

 

Konfigurišite postavke softvera prema našem 3D štampaču 
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Nakon pokretanja softvera, treba da odaberete svoj 3D štampač. Cura nudi širok spektar 

FDM 3D štampača različitih proizvođača, ali ako ne pronađete svoj 3D štampač, možete 

sami napraviti konfiguraciju prema parametrima štampača koji imate. 

Korak 1: Odaberite proizvođača svog 3D štampača. 

 

Ako je vaš 3D štampač 

proizveden od strane Ultimaker, 

odaberite Ultimaker printer; 

ako nije, odaberite Non 

Ultimaker printer 

Napomena: Štampač kojim 

ćemo se baviti u ovom 

priručniku je Non Ultimaker 

štampač. 

 

Ako je vaš štampač umrežen sa 

računarom, automatski će se 

pojaviti. 

Ako nije, odaberite “."Add a 

non-networked printer" 
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Na levoj strani su proizvođači 3D 

štampača, a na desnoj strani 

imate ime 3D štampača. 

Korak 2: Izaberite svoj 3D štampač 

 

 

Odabiremo naš 3D štampač i kliknemo 

"Add" 

Napomena: Štampač kojim ćemo se 

baviti u ovom priručniku je Creality Ender 

3 Max. 

Korak 3: Konfiguracija vašeg 3D štampača.  
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Softver automatski prikazuje parametre za vaš 3D štampač. Ako se, slučajno, ne 

poklapaju sa parametrima koje je dao proizvođač, imate priliku da ih promenite. Ako je 

sve u redu, kliknite. "Next" 

Napomena: Dimenzije za X, Y i Z osu nikada ne smeju biti veće od stvarnih vrednosti 

osa 3D štampača.

 

Korak 4:  

Izbor materijala za štampanje.Nakon pokretanja softvera, treba da odaberete materijal sa 

kojim ćete štampati. Cura vam nudi veliki izbor štamparskih materijala kao što su 

ABS,PLA, PETG, TPU i PVA. 

 

 

Napomena: Mi koristimo PLA filament 
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Korak 5: Izbor veličine dizne. 

Odaberite veličinu dizne vašeg 3D štampača.

 

Nampomena: Dizna našeg štampača je 0.4mm 

 

4. Učitavanje 3D modela u programu Cura. 
Pre nego što uvezete 3D model u softver, osigurajte da je vaš model konvertovan u jedan 

od sledećih formata: STL, OBJ, X3D ili 3MF. Ovo su formati koje podržava Cura. 

 

 

Nakon što vidite 3D model na platformi, možete početi da ga pripremate za 3D štampan 
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Navigacija 

Levi klik – 

Selektovanje 

modela 

Desni klik- 

okretanje radne 

površine 

Srednje dugme- 

pomeranje radne 

površine 

Okretanje srednjeg 

dugmeta- zumiranje 

    

 

 

 

 

5. Komande 

5.1 Gornja traka menija 

 

Gornja traka menija uključuje sledeće opcije: Datoteka, Uredi, Prikaz, Postavke, 

Ekstenzije, Preferencije i Pomoć. 
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File 

 

 

Klikom na File otvoriće se 

komande. such as: 

New Project- Ako želite da 

započnete novi projekat. 

Open files- Ako želite da 

otvorite već postojeći model. 

Open recent- Ako želite da 

otvorite model na kojem ste 

prethodno radili. 

Save project- Ako želite da 

sačuvate projekat na kojem 

trenutno radite. 

Export- Ako želite da 

eksportujete model u drugi 

format. 

Quit- Ako želite da izađete iz 

programa. 

 

Edit 

 

Klikom na Edit otvaraju se opcije kao 

što su (poništi) otkazivanje date 

komande i vraćanje na prethodno 

stanje modela.  

(„Undo“ se takođe može izvršiti 

pritiskom na ctrl+z na tastaturi.) 

 

Ostale opcije su opisane u nastavku u 

sekciji: meni levim klikom. 
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View 

 

 

 

Klikom na View imate 

mogućnost da odaberete kako 

da prikažete model, izaberite 

poziciju iz koje ćete imati najbolji 

pregled modela. 

 

Settings 

 

Klikom na Settings: 

 

- U polju Ekstruder 1 imate priliku da 

promenite veličinu mlaznice i 

promenite materijal sa kojim ćete 

štampati.. 

 

- U polju Printer možete odabrati 

štampač sa kojim ćete raditi (ako imate 

više dostupnih štampača, treba da 

odaberete štampač sa kojim ćete 

štampati model na kojem radite). 

 

 

 

Preferences 

Klikom na Preferences i Configure Cura imate mogućnost da izvršite sve 

promene opisane do sada, na naprednom nivou. 
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5.2 Operacijska traka 

 

Traka operacija uključuje sledeće funkcije: Pomeri, Skaliraj, Rotiraj, Ogledalo, Postavke 

po modelu i Blokada podrške. 

Pre nego što možete koristiti ove funkcije, model mora biti odabran. 

 

 

 

Pomeranje- Move 

Izvršite operacije pomeranja na odabranom modelu, uključujući pomeranje u X/Y/Z osi. 
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Skaliranje- Scale 

Izvršite operacije skaliranja na odabranom modelu, uključujući skaliranje u X/Y/Z 

pravcima, prebacivanje ili zaključavanje Uniformnog za skaliranje i vraćanje na početno 

stanje. 

NAPOMENA: Kada uvozite modele u Cura, važno je proveriti postavke skaliranja. 

Ponekad, podrazumevano skaliranje može biti različito (10x manje), što uzrokuje da 

model izgleda manji. Možete prilagoditi skaliranje u Curi kako biste uskladili veličinu 

vašeg modela sa veličinom u programu za 3D modeliranje koji ste koristili. 

Prvo odaberite model, zatim kliknite na komandu Skaliraj (kutija označena crvenom 

bojom ispod slike). Nakon što ste izvršili prethodne korake, imate mogućnost da 

promenite veličinu modela na dva načina. Prvi način je da promenite dimenzije modela u 

milimetrima, dok je drugi način kroz promenu dimenzija u procentima. Ova dva načina 

promene su povezana, što znači da ako promenite dimenziju modela u milimetrima, 

proprocentualna vrednost će se takođe promeniti. 

 

 

1. Resetuj - Komanda za vraćanje dimenzija modela, tj. vraćanje na originalne 

dimenzije modela. 

2. Uniformno skaliranje - Odabirom komande uniformnog skaliranja prilikom 

promene jedne dimenzije, ostale dimenzije će se menjati linearno u istom odnosu 
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kao što je prethodno odabrano. Ako komanda nije odabrana, možete promeniti 

dimenzije modela za svaku veličinu posebno (X, Y ili Z). 

NAPOMENA: Naš model je 10 puta manji od originalnog, pa ćemo koristiti opciju za 

promenu dimenzija u procentima (100x10=1000%) sa odabranim poljem za uniformno 

skaliranje. 

 

 

Rotacija- Rottate 

Omogućava vam da rotirate model kako želite, izbegavajući potrebu za podrškom.

 

NAPOMENA: Ako model ima delove obeležene crvenom bojom, to ukazuje na to da su 

ta područja potrebna strukture podrške. Da biste smanjili potrebu za podrškom, 

prilagodite model tako što ćete eliminisati crvena područja ili smanjiti njihovu prisutnost. 

Ako rotirate ovaj model, primetićete da su slova na donjoj strani obeležena crvenom 

bojom, pa ćemo okrenuti ovaj model kako ne bi bilo crvenih delova na njemu. 
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Preslikavanje- Mirror 

Omogućava vam da preslikavate model kao u ogledalu u pravcu svih osa.

 

 

Ovom komandom možete okrenuti modele i na primer, prilagoditi ih za štampu. 

 

 

5.3 Podešavanje modela 

 

Omogućava vam da promenite tip mreže i postavke modela. 
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Blokiranje potpora- Support blocker 

Omogućava vam da blokirate područje tako da se potpora neće generisati. 

 

 

Desni klik meni- Right click menu 

Desnim klikom na model otvara se meni u kojem imate nekoliko opcija. 

 

Center selected- pozicionira izabrani model na 

sredinu prostora za štampanje 

Multiply selected- broj kopija modela 

Arrange all models- raspoređuje modele, 

jedan pored drugog 

Arrange all models in a grid- raspoređuje 

modele na određenoj udaljenosti jedan od 

drugog, mrežno 

Multiplay- Umnožavanje 

 

 

 

 

► 

 

Arrange all models- Raspoređuje sve modele 
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► 

 

Arrange all models in a grid- Raspoređuje sve modele, mrežno 

 

 

 

 

► 

 

 
 

6.4  Podešavanje štampe 
 

 

Ovo je polje gde podešavate štampu prema svojim potrebama. 

Kvalitet štampe- Print Quality 

Ovde odabirete kvalitet štampe za svoj model, tj. visinu sloja. Možete odabrati iz 

postojećih profila gde su sačuvane vaše prethodne postavke štampe, ili kreirati nove sa 

prilagođenim parametrima. 
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Takođe možete ručno uneti visinu sloja u polje Layer height

 

 

NAPOMENA:Veće vrednosti dovode do brže štampe u nižoj rezoluciji, dok manje 

vrednosti dovode do sporije štampe u višoj rezoluciji. Za naš model koristimo standardni 

kvalitet 0.2mm. 

 

5.5  Zidovi 

 

 

Ovo je polje u kojem je data debljina zidova pre nego što počne da se puni unutrašnji deo 

modela, tj. broj linija koje ekstruder pravi duž ivica modela. Ova dva polja su međusobno 

povezana, dok oba zavise od  širine sloja. 

. 
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Wall Thickness  0.8mm 

Wall Line count  2 

Wall Thickness  2mm 

Wall Line count 5 

  

 

Gornji i donji sloj- Top/Bottom 

 

 

U ovom polju određujete debljinu dna i vrha modela, tj. koliko slojeva da napravite pre 

nego što počne punjenje modela. Imate opciju da ih postavite sa istom vrednošću, ali i sa 

različitim vrednostima za gornji i donji sloj. 

  

Bottom thickness  0.8mm 

Bottom layers         4 

Bottom thickness  2mm 

Bottom layers         10 

 

Ispuna- Infill 
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U ovom polju određujete gustinu popunjavanja modela u procentima, kao i oblik 

popunjavanja. Postoje različite mogućnosti. 

 

NAPOMENA: Što je veći procenat popunjavanja, model je čvršći, zahteva više 

materijala i više vremena za izradu, dok niži procenat znači manje materijala (lakši 

model) i manje vremena za izradu. 

  

Infill 10% Infill 50% 

 

 

 

Šabloni ispune- Infill pattern 

 

Šabloni ispune prilikom štampanja: 

•  Line i zig zag ispune, se smenjuju u pravcu naizmeničnih 
slojeva, smanjujući količinu materijala 
 

•  Grid, triangle, tri-hexagon, cubic, octet, quartet cubic, 
cross i concentric ispune imaju punu štampu u svakom 
sloju. 
 

• Gyroid, cubic, quarter cubic i octet ispune se menjaju sa 
svakim slojem kako bi se obezbedila ravnomernija 
raspodela čvrstoće u svim pravcima. 
 

• Lighting ispuna pokušava da minimizira popunjavanje, 
podržavajući samo plafon objekta. 
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Lines Zig-Zag 

 

  

Grid Triangles 

 

  

Cubic Tri-Hexagon 

 

  

Octet Quartet Cubic 
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Cross Concentric 

 

  

Gyroid Cross 3D 

 

  

Cubic Subdivision Lighting 

 

 

5.6 Materijali 

 

 

 

U ovom polju unosite temperaturu mlaznice i temperaturu radne površine (ako 3D 
štampač s kojim radite ima grejanu radnu površinu). 
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Temperatura mlaznice i radne površine zavisi od vrste materijala sa kojim 
štampate. 

Materijal PLA TPU ABS 

Temperatura 
štampe 
(mlaznice) 

180 ºC to 230 ºC 210 ºC to 230 ºC 240 ºC to 260 ºC 

Temperaura 
radne 
površine 

40 ºC to 60 ºC 30 ºC to 60 ºC 95 ºC to 110 ºC 

 

Napomena: Temperatura zavisi od uslova u kojima štampate. 

Napomena: 3D štampač na kojem ćemo štampati nije zatvoren. Budući da ćemo 

štampati u uslovima gde će biti kretanja ljudi, preporučuju se maksimalne 

temperature jer postoji protok vazduha koji hladi filament, što može dovesti do 

deformacije štampanog objekta. 

 

Brzina 

 

Brzina kojom se dešava štampanje 

Optimalna brzina štampe za vaš objekat zavisi od vaših prioriteta, afiniteta i 

mogućnosti štampača. Niže brzine štampe mogu poboljšati kvalitet površine, 

dimenzionalnu tačnost i preciznost, ali takođe povećavaju vreme štampe i rizik od 

zapušavanja i blokiranja. Više brzine štampe mogu smanjiti vreme štampe i 

potrošnju materijala, ali takođe smanjuju kvalitet površine, dimenzionalnu tačnost 

i preciznost. 

 

Putanja- Travel 

 

Povlači filament kada mlaznica prelazi preko neštampane površine. 
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Povlačenje je funkcija namenjena eliminisanju končića povlačenjem filamentu 

kada se štampačka glava pomera na novu lokaciju. 

 

Hlađenje- Cooling 

 

Omogućava ventilatore za hlađenje tokom štampe. Ventilatori poboljšavaju 

kvalitet štampe na slojevima sa kratkim vremenom nanošenja slojeva na 

ispustima- izbočenjima. 

Potpora- Support 

 

Generiše strukture za potporu delovima modela koji imaju izbočenja. Bez ovih 

struktura, takvi delovi bi se srušili tokom štampe. Softver će obeležiti crvenom 

bojom deo koji visi i kome je potrebna potpora. 

 

Struktura potpora 

 

Birate između dostupnih tehnika za generisanje potpora. 

Normal potpora stvara strukturu podrške direktno ispod delova koji vise i spušta 

te zone pravo dole. 
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Tree potpora stvara grane prema izbočenim oblastima koje podržavaju model na 

vrhovima tih grana, i omogućava granama da se kreću oko modela kako bi ga što 

više podržale sa radne površine. 

 

  
Normal support Tree suport 

 

Potporna postavka 

 

Prilagođava postavljanje strukture potpore. Postavljanje može biti podešeno na 

dodir sa radnom površinom ili svuda (Everywhere). Kada je postavljeno 

Everywhere, strukture potpora će se štampati i na modelu. 

   
Without support Everywnare TuchingBuildplate 
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Ugao izbočenja potpora 

 

Minimalni ugao izbočenja za koji se dodaje potpora. Pri vrednosti od 0º sva 

izbočenja su podržana, dok 90º ne pruža nikakvu podršku. 

Horizontalno širenje potpora 

 

Pomeranje se može primeniti na potporne strukture u pravcima X i Y. Vrednosti 

veće od 1 čine potporne strukture šire od modela čime se dobija čvršća podrška. 

Odabrom oslonaca koji je manji od 1mm, oslonac je manji od modela čime se 

dobijaju veoma tanke potporne strukture. 

  
Support Horizontal Expansion 

0.8mm 
 

Support Horizontal Expansion  
5mm 
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5.7 Prijanjanje na radnu površinu 

 

 

Ova opcija je pogodna ako štampate veći objekat. 

Kada se štampaju veći objekti, dolazi do većih temperaturnih šokova, što može uzrokovati 

uvijanje objekta i njegovo odvajanje od platforme za štampanje. Da bi se izbegli ovi 

problemi, koristi se adhezija za osnovnu platformu, koja omogućava da objekat pokrije 

veću površinu platforme za štampanje i spreči njegovo odvajanje. 

Različite opcije pomažu da se poboljša prijanjanje prvog sloja vaše ekstruzije i adhezije 

na radnu površinu. 

Brim dodaje jedan sloj ravne površine oko osnove vašeg modela kako bi se sprečilo 

uvijanje. 

Raft dodaje gustu mrežu ispod modela. 

Skirt je linija koja se štampa oko modela, ali nije povezana s njim. 

  
 

Brim Raft Skirt 

 

 

5.8  Napredna podešavanja 

 

Prethodno pomenuta podešavanja su osnovna. Ako vam trebaju dodatna podešavanja, 

uvek možete uključiti dodatne opcije. 
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Da biste aktivirali dodatne opcije, kliknite na "Preferences", zatim izaberite "Settings", i 

videćete sve dostupne postavke u Curi. Možete odabrati već postojeće profile ili sami 

konfigurisati odabirom postavki. Nakon što izaberete postavke, one će se pojaviti u 

podešavanjima štampe. 

 

Sečenje 

Nakon što ste napravili sve potrebne postavke za vaš model, kliknite na "Slice". 

.  

Klikom na "Slice", model se deli na slojeve i spreman je za štampu. Prikazuje vam se 

vreme štampe i koliko će materijala biti potrošeno tokom štampe. Model se konvertuje u 

G-code, koji možete sačuvati na svom računaru ili USB disk da biste ga preneli na svoj 

3D štampač. 

Napomena: Ne možete otvoriti G-code u Cura-i, pa ako želite da sačuvate projekat sa 

svim izmenama, sačuvajte ga koristeći opciju "Save Project" koja se nalazi u gornjem 

meniju: File – Save project. 

Pre nego što sačuvate G-code iz modela, preporučuje se da pregledate simulaciju štampe 

kako biste izbegli greške koje se mogu pojaviti tokom podešavanja. 
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Pregled 

Opcija pregleda vam omogućava da vidite simulaciju štampe. Da biste mogli da 

pregledate izlaz, potrebno je da izvršite sečenje (slice). 

 

*Na desnoj strani (označenoj crvenom bojom u ovom priručniku) nalazi se skala za svaki 

sloj štampe, koja vam omogućava da uvek znate koji sloj pregledate. 

* Na dnu (označenom plavom bojom u ovom priručniku) nalazi se dugme za reprodukciju 

koje pokreće pregled (simulaciju). 

Uvek možete da se vratite na podešavanja štampe ako želite da prilagodite neke postavke, 

ali sa svakom izmenom gubite mogućnost pregleda, što znači da morate ponovo kliknuti 

na "Slice". 

Pregled boja 
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U ovom polju možete promeniti boje 

pregleda 

-izbor boje podrške, 

-odabir boje za spoljašnje zidove,  

-pregled brzine različitih slojeva 

 

 

Ako ste zadovoljni rezultatima, možete sačuvati G-code i preneti ga na 3D štampač. 

 Uživajte u štampi! 
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Primeri 
 

 Primer 1 

Prateći priručnik, napravite postavke za model "STAMP": 

3D štampač koji koristimo je: Ender 3 Max 

Materijal: PLA 1.75mm 

 

1. Uvezite 3D model. 

2. Veličina modela treba da bude 60x40x5 mm. 

3. Model ne treba da ima potporu 

4. Popunjenost 20% 

5. Napravite model koji će se koristiti kao pečat 

6. Sačuvati projekat 

Prvo biramo štampač sa kojim ćemo štampati model, u ovom slučaju Creality Ender 3 

Max. 

"Naš štampač nije na listi, moramo ga dodati pomoću komande 'Dodaj štampač'." 

 

Korak 1 

 

 

Otvori će se prozor u kojem moramo odabrati štampač koji nije proizveden od strane 

Ultimaker-a. 

Korak 2 
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Korak 3 

 

 

Korak 4 
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Korak 5 

 

Korak 6 

 

Korak 7 

 

Korak 7 završava selekciju 3D štampača. 

Sledeće, treba da izaberemo materijal (PLA) koji ćemo koristiti za štampanje objekta. 
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Korak 8 

 

 

1. Sada možemo da uvezemo model koji želimo da prilagodimo i odštampamo. 

Korak  9 

 

Korak 10 

 

 

Korak 11- Podešavanje dimenzija objekta 60x40x5mm 

Izaberite model i odaberite komandu SCALE. 
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Korak 12 

Isključite uniformno skaliranje i unesite željene dimenzije za x, y i z. 

 

- Isključite opciju za potpor 

Korak 13 

 

Korak 14 

 

- Popunjavanje modela 20% 

 

 

 

 

Korak 15 
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- Pripremite model da bude pogodan za upotrebu kao pečat. 

 

Korak 16 

 

 

 

Korak 18- Čuvanje projekta 
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Primer 2 

U skladu sa priručnikom, postavite opcije za model "Slika 1": 

3D štampač koji koristimo: Ender 3 Max 

Materijal: PLA 1.75mm 

1. Uvezite 3D model. 

2. Veličina prve figure treba da bude 10mm širine i 20mm visine. 

3. Napravite 4 figure koje će biti raspodeljene na mreži. 

4. Premestite figure u donji levi ugao radne površine. 

5. Postavite parameter štampe u uslovima gde se ljudi kreću u blizini štampača. 

6. Generisati G-kod. 

Pošto smo u prethodnom zadatku odabrali isti štampač i materijal, možemo preći na 

parametre modela. 

1. Korak 1- Učitavanje 3D modela 
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Korak 2 

 

 

   Uvezli smo model, ali vidimo da leži horizontalno; potrebno je da ga uspravimo. 

Izaberite model i kliknite na komandu Rotate – izaberite površinu koju želite da poravnate 

sa radnom platformom, a zatim odaberite donju stranu modela. 

 

Korak 3 
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Sad možemo da pređemo na sledeći korak 

 

Korak 4  

Veličina figure 1 treba da bude 10mm širine i 20mm visine. 

    Izaberite model, kliknite na komandu Scale i promenite vrednosti za X, Y i Z. 

 

 

Korak 5 

Napravite 4 figure koje će biti raspoređene na mreži. 

Desnim klikom na model izaberite komandu "Multiply Selected". 

 

 

Korak 6 
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   Izaberite broj kopija (u našem slučaju 3), odaberite raspored u mreži i pritisnite OK. 

 

 

 

 

Korak 7  

Pomeranje figure u donjem levom uglu radne površine 

Desnim klikom bilo gde na radnoj površini izaberite "Select All Models". 

 

 

Korak 8 

Prvo kliknite na zelenu strelicu i prevucite je prema dole da biste pomerili modele naniže, 

zatim na crvenu strelicu i prevucite je ulevo da biste pomerili modele ulevo. 
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Postavljanje parametara štampe u uslovima gde se ljudi kreću u blizini štampača. 

Pošto će se prilikom štampe veći broj ljudi kretati pored štampača, to može stvoriti jači 

protok vazduha koji može odvojiti objekat sa radne platforme. Da bismo sprečili 

odvajanje, potrebno je da povećamo temperature štampanja i temperaturu radne 

platforme, kao i da uključimo build plate adhesion. 

 

Korak 9 

Temperatura štampe: 220°C, temperatura radne platforme: 80°C. 

 

 

 

 

Korak 10 

Izaberite opciju Brim u sekciji za prianjanje radne platforme (Build plate adhesion). 
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Generisanje G-koda 

Korak 11 

 

Nakon što završite sva podešavanja, klik na Slice da bi se generisao G-kod 

Korak 12 

Kliknuti save to Disk i sačuvajte G-Code pod imenom po vašem izboru. 
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  Sada možete uneti G-Code u štampač i započeti štampanje. 
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